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Section 1: Customizing Project

In this section you will learn how to:
· Use the Gantt chart XE "Gantt Chart"  view
· Use the Tracking Gantt XE "View Commands:Tracking Gantt"  view
· Use the Network Diagram XE "View Commands:Network Diagram"  view
· Adjust timescales
· Change the font
· Format individual Gantt bars
· Format Gantt chart XE "Gantt Chart"  categories
· Add text to Gantt Bars
· Add a text box to a Gantt chart XE "Gantt Chart" 
· Add menus
· Customize menus
· Show and hide toolbars
· Customize toolbars

· Create toolbars

· Change the date format

· Change your user name

· Set time units

· Enable AutoSave XE "AutoSave" 
· Set calculation options

· Set security options

Lesson 1.1: Using Advanced Views

One of the biggest advantages to using Microsoft Project 2007 is its ability to display data in many different ways. You should already know how to arrange windows, split the screen, and access a number of basic views in Project. To start this section, we’re going to kick things off by learning some more advanced ways you can use views in Microsoft Project.

Using the Gantt Chart XE "Gantt Chart"  View
This is probably the most widely used view in Project; as a matter of fact, it is Microsoft Project’s default view.  XE "Gantt Chart:Switching To" 
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On the left hand side, we have the task entry sheet; on the right, we have a timeline with our various tasks listed. As you already know, you can add and delete tasks from the task entry sheet, and you can adjust the duration and scheduling of tasks by dragging the Gantt bars in the Gantt chart XE "View Commands:Gantt chart"  with your mouse.
Using the Tracking Gantt XE "View Commands:Tracking Gantt"  View
You can access the Tracking Gantt XE "View Commands:Tracking Gantt"  view from the View menu.
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The Tracking Gantt XE "View Commands:Tracking Gantt"  view looks quite similar to the Gantt chart XE "Gantt Chart"  view, except that it shows you what percentage of each task has been completed.
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You can also see lined Gantt bars (which look like they are made of small cells or blocks) that follow under the summary task Gantt bars. These give you an idea of how much of the summary task (phase) is complete.

If you saved a baseline for your project, you will see the original baseline scheduling in the form of grey Gantt bars. You will also see the current project scheduling in the form of blue Gantt bars. If your project tasks have been delayed, or moved forward or back in time, you will see slippage between the blue bars (current) and the grey bars (base line). If you are right on schedule with no changes or delays, both sets of bars will be in sync.

Using the Network Diagram XE "View Commands:Network Diagram" 
Project’s Network Diagram XE "View Commands:Network Diagram"  view is also accessible from the View menu. Here is what it looks like:  XE "View Commands:Network Diagram" 
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This diagram view shows you each task in a separate box. If tasks are linked, you will see lines connecting them. Summary tasks are shown as trapezoids, while tasks with no dependents are shown as rectangles. Tasks that are overdue or critical appear in red.

Although this view may not be what you are used to, you can still create and edit tasks in this screen. To create a new task, click the Insert menu and click New Task. To edit a task, double-click it.
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If you right click on a task box, you will see a pop up menu with a selection of options.

[image: image6.png]=
Delte Task.

Format o,
(= Taskirformatin
o] Taskbiotes

[P — /

Layout selecton Now

Layout Related Tasks Now [emporsey power

= N >
2, Hyperink,

et ermparary vaar zer
Er )
ey oe e
T Aewm et





You can also use the zoom out button ([image: image7.png]Q |



) to see more of the diagram. 
In the zoomed out view shown below, you can see the critical tasks (and the critical path) for the project.
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Adjusting Time Scales
When you are using any of these three views, (Gantt chart XE "Gantt Chart" , Tracking Gantt XE "View Commands:Tracking Gantt" , or Network Diagram XE "View Commands:Network Diagram" ), you can adjust the timescale XE ""  that you see in different ways.

The first is to use the Zoom In and Zoom Out buttons on the standard toolbar ([image: image9.png]


).  You can also click the View menu and click Zoom for a more precise zoom tool.
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The third method is to adjust the timescale XE "Timescale"  directly. This method is available when you are using the Gantt view or Tracking Gantt XE "View Commands:Tracking Gantt"  view (when the timescale XE "Timescale:Adjusting"  is visible on the top of the Gantt chart XE "Gantt Chart" ).

 Click the Format menu and click Timescale to display the following dialogue:  XE "Timescale:Formatting" 
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In this dialogue, you can choose how many tiers are displayed (using the Show field), and which unit each tier will use (using the Units field). You can also set the label style, alignment, and size for each tier.

Changing Your Font

It is fairly easy to change the font XE "Font, Modifying"  for certain elements of your project. To do this, first select the text that you want to change.
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Next, click the Format menu and click Font.
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The next step is to use the Font dialogue box to specify your font options.
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You can see a preview of your selected font and formatting in the sample window. When you are ready to apply your changes, click the OK button.
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Remember, you cannot undo font changes with the Undo button, so be careful when changing these settings. 

If you want to find out what the font settings are for a particular section of text, select some text that has the font you are interested in, and then display the Font dialogue.
[image: image16.png]18
£l
2
2
5
£
%
B
27
£
£
El
El
2
E
El
£
E
Ed
El
E]
o
a
2
s
a
s

@ Task Name. Duration

Installtemporary power 2days
Installtemporary water service 2days
Setup se offce. 3days
Setine and grade benchmarks. 3days
Prepare ste - lay down yard and temporary o 2days

= Site Grading and Utities 3days
Clear and grub st 3days

Font sty

o] Regular

Arial Hack. = el
0 sl Narrow Bold
O frial Rounded T Bol ¥ |Bold Italic

[underline

Coor: Sample
7 Autometic
Background Color: aaBbvyIz
7 Autometic

Backyround pattern

Install preumatic tube in elevator pit 3days




The details for the selected font will appear in the dialogue’s fields.
Lesson 1.2: Formatting the Gantt Chart

Now that you are familiar with the Gantt chart XE "Gantt Chart"  views, it is time to learn how to format it. The good thing is that some of these formatting tools can be applied to other views as well, such as the Network Diagram XE "View Commands:Network Diagram"  view.
Formatting Individual Bars
You can format individual bars in the Gantt chart XE "Gantt Chart:Formatting bars"  by double-clicking on them. When you double click on a Gantt bar, the following Format Bar dialogue will appear.
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In this dialogue, you can choose any shape, type, and colour that you want for the start, middle, and/or end of the Gantt bar.
As an example, here is an image showing some Gantt Bar settings:
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You will notice that a preview of your new Gantt bar style will appear in the Sample area.
If you click the OK button, the new settings will be applied to the Gantt bar that you double clicked on to display the dialogue.
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If you don’t like the appearance of your new Gantt bar, double click it again to display the dialogue, and then click the Reset button to return to the default color and shape scheme.
Formatting Categories
If you want to change the appearance of all Gantt bars of a certain type, or the appearance of split or summary tasks, there is a more efficient way than going through the project and changing each Gantt bar individually.
If you double-click on a blank spot in the Gantt chart XE "Gantt Chart:Formatting categories"  area (or click the Format menu and click Bar Styles), you will see the following dialogue:
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Compared to the Format Bar dialogue, there are a lot more options that you can configure with this dialogue, but the way you configure these options is essentially the same as before.

At the top, select a Gantt bar type, and then use the fields (drop lists) at the bottom to change the appearance of the selected type. Once you set up one category of Gantt bar, you can then select and set up the next. Use the scroll bar (shown in the red square in the image above) to see other categories of Gantt bars and symbols.

As an example, here is an image of the Bar Styles dialogue after some of the settings have been reconfigured.
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The following image shows the resulting Gantt chart after clicking the OK button.
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Although there is no Reset button in the Bar Styles dialogue, you can undo the changes you apply by clicking the Undo button ( [image: image23.png]


).

If you click the Insert Row button, you will be able to create your own custom Gantt symbol/bar.
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You can specify what type of task your custom bar type will be applied to by choosing from the Show For drop list.

To remove a row from the dialog’s list, select it and click the Cut Row button.

Adding Text to Bars
You can add text to individual bars using the Bar Text tab in the Format Bar dialogue:  XE "Gantt Chart:Adding text to"  
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In the dialogue, use the drop lists associated with a region around or in the bar to display one of a number of possible data options. In the image above, %Complete is selected so that it will be displayed in the inside of the bar.

Here is the result after you click the OK button. 
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As before, you can click the Reset button to apply Project’s default settings. 
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You can also use the Bar Styles dialogue to add text to various categories of Gantt bars.
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Just select a bar type from the top part of the dialogue, and choose the type and location of the text in the bottom part of the dialogue.
You can enter text directly into a given location field, or click the drop-down arrow to choose from a list of text elements. In either case, the textual information will be displayed on the selected bar (if you are changing individual bars with the Format Bar dialog) or on every bar in the selected category (if you are using the Bar Styles dialog).
Adding Text Boxes to a Chart
If you want to add annotations directly to the Gantt chart XE "Gantt Chart:Inserting text boxes" , you can always add a text box. To do this, first click the Insert menu and then click the Drawing option. 
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If you perform this action, you will see the following toolbar appear on your screen:
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You can add any of the shapes visible on the drawing toolbar XE "Toolbars:Drawing"  by clicking on the shape icon on the toolbar, and then drawing the shape out onto your Project chart by dragging your mouse. (The text box shape is shown with a red rectangle around it in the image above.)
When you click the text box icon, your mouse pointer will turn into a crosshair. You can then use your mouse to drag the text box shape out on your screen.
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Once you release your mouse button, you will be able to type in the text box.
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You can move the text box by dragging it with your mouse, or resize it by dragging its outer edges. To delete the text box, click it to select it, and then press the Delete key on your keyboard.
Lesson 1.3: Customizing How Project Looks

So far, we have dealt with changing the look of particular elements within Project, such as views, Gantt charts, and text. Next, we will learn about customizing the actual Project 2007 interface to change how Project looks as an application. 
In this lesson, we’ll focus on customizing menus and toolbars so that you can get the most out of Microsoft Project. Remember that customized menus and toolbars are saved in Project’s global template, so these changes will be loaded every time you open Project.

Adding Menus
By default, Project Professional XE "Microsoft Project 2007:Professional edition"  2007 shows you eleven commonly used menu headings; the Project icon, File, Edit, View, Insert, Format, Tools, Project, Report, Collaborate, Window, and Help.
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 You should know, however, that there are dozens of additional menus XE "Menus:Adding"  that you can add to the Project interface. To see the available menus, right-click on a blank toolbar area and click the Customize option in the pop up menu.
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When you perform this action, the Customize dialogue will open to display the options under the Commands tab.
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In the Categories list of this tab, scroll down to Built-In Menus.
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Now you can take any of the items in the Commands list and drag and drop them onto the menu bar at the top of the Project screen.
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When you drag a menu heading from the Commands list to the menu bar, the menu will become available for use in the typical way.
[image: image38.png]Collaborate.

Window

Help

Eormats

Contents
Notes
Hyperinks

Entire Tack.

Cti+Del





If you want to remove XE "Menus:Removing"  a menu from the menu bar, open the Customize dialogue box and then drag the menu off the screen. (You can do this with any menu, even the default Project menus.)

Customizing Menus
When you display the Customize dialogue box, you should notice a command called New Menu in the Categories list. This particular option is for creating your own custom XE "Menus:Creating custom"  menus.
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If you drag this menu to the menu bar, a blank menu will appear. You can then customize this blank menu by choosing any category, picking a command, and dragging it to the new menu.
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In this example, a new menu with a recently used file list was created.
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You can even use this same process to add to add commands to the existing Project menus. In this image, we are adding a “75% complete” option to the Project menu.
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Here is the Project menu after the option has been added.
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You can also edit individual menu commands XE "Menus:Editing commands"  by opening the Customize Dialogue box, and then opening the menu and right clicking on the menu command in question.
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When you right click, you will see a menu that will allow you to reset, delete, or edit the command in question. You can customize newly added menu commands and pre-existing menu commands in this way.

Showing and Hiding Toolbars
In addition to customizing menus, you can also show or hide the various Project 2007 toolbars. 

One way to display toolbars XE "Toolbars:Showing"  is to right-click on a blank space beside in the toolbar area and put checks by the toolbars that you want to show, or uncheck those that you want to hide.
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Another way to configure toolbars is to display the View menu, choose Toolbars, and check or uncheck toolbars from the list.  XE "Toolbars:Hiding" 
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You can also open the Customize dialogue and click the Toolbars tab. This will display a dialogue box with options to check or uncheck toolbars.
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Customizing Toolbars
If you wish, you can add or remove buttons from Project 2007 toolbars. The first step is to open the Customize dialogue box. Next, click the Commands tab and choose a category.  XE "Toolbars:Customizing" 
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You will now be able to drag a command from Commands list (circled in red in the image above) to the toolbar of your choice.
You can also edit toolbar buttons when you have the Customize dialogue open. Just right-click the button on the toolbar and choose your action from the pop up menu.  XE "Toolbars:Editing commands" 
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Remember, the Customize dialogue must be displayed first.

You can easily change a toolbar’s position on the screen by placing your mouse pointer on the end of the toolbar and dragging it to its new location. When you do this, make sure you place your pointer on the series of dots at the end of the toolbar. This will allow you to drag it with your mouse.  XE "Toolbars:Moving" 
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You can attach toolbars to the sides, top, or bottom of the screen, or have them floating in the middle as shown in the sample image that follows.
[image: image51.png]Edt Vew Insert Fomat Took Project Report Colaborate Window Help NewMenu Type aquestion for help < 8 X

i | B | 9 | Neow Resource From - | B & % | (1) F & | T

i)

© [TaskName Dustion | Stat  |Sep3,06 Sep 10,06 Sep 17,06 Sep 24,06 et 1,06 Octe 6 A
S M [T WITIF[S[S M7 WIT[FS (S M7 WIT[FS S M [T WWITIFS (S [MIT WIT[FIS[S [MIT W]

PRI I-C-F| 8
o Grous -RQFiEe

% & = g ghonr | wl s =
By EE= e -

« L=

i

am >





Creating Toolbars

With Project 2007, you can customize your own toolbars to meet your own requirements. To do this, first open the Customize dialogue and click the Toolbars tab; then, click the New button.  XE "Toolbars:Creating" 
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When you press the New button, a dialogue will appear asking you to name the new toolbar.

[image: image53.png]New Toolbar

Tookar name:
Custom 1





After you name it and click the OK button, the toolbar will appear on the screen. 
At this point you can drag and drop commands from the Customize dialogue to your new toolbar.
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Just like your standard toolbars, you can drag customized toolbars to any location on your screen. In addition, they will be available on the toolbar list so you have the option of showing or hiding them.
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Lesson 1.4: Setting Project’s Options

You can also modify the Project application to suit your needs is by customizing its options. The Options dialogue XE "Options Dialogue:Opening"  can be opened by clicking the Tools menu and clicking Options. All options that you set in the dialogue will only apply to the current project, unless you click the Set As Default option (which is not available for all choices). 
Note that no tab has a Reset option, so make sure you remember which options you changed. 
Changing the Calendar or Date Format
To change the default calendar settings, use the options under the Calendar XE "Options Dialogue:Calendar tab"  tab.
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This tab will allow you to specify the start day, the start time, the end time, the hours per day, and the hours per week for the default calendar. These settings will be applied to tasks if you do not specify another type of calendar (other than the default) explicitly.

Remember, to apply these settings globally in Project (rather than just the current project), click the Set as Default XE "Options Dialogue:Set as Default"  button.
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To change the date format, use the View tab XE "Options Dialogue:View tab" .
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Under this tab, you can scroll through the items in the Date Format drop list to select the date format of your choice.  XE "Options Dialogue:Changing date format" 
Changing Your User Name and Undo Levels
To change your user name from within Project 2007, display the Options dialogue, and then click the General tab.  XE "Options Dialogue:Changing user name" 
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In the User Name field, enter the user name that you want to use. (This username will appear in the Author field under the Summary tab of the Properties dialogue.)

You can also change how many levels (steps) you can retrace with the Undo button. Just use the small arrows in the Undo Levels field to increase or decrease the amount of undo actions that can be taken.  XE "Options Dialogue:Setting undo levels" 
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The default amount of undo levels is set at 20. (Project 2007 will allow you to set the amount of undo levels as high as 99.) If you want to change this amount for all projects, don’t forget to click the Set as Default button after you adjust the value. 

Setting Time Units
Project 2007 also allows you to change the units used for time values. The options to do this are available under the Edit tab.  XE "Options Dialogue:Setting time units" 
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Just select a different time unit from the drop list provided for any of the time fields that you want to change.  XE "Options Dialogue:Edit tab" 
Here is a Task Entry list and corresponding Gantt chart with the default time units.
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Now we will change the time unit settings to those shown below.
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To apply these setting to this project click OK. To apply these setting globally, click the Set as Default button and then click OK.
Now, with these changes, the Task Entry list will look like the following:
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Enabling AutoSave XE "AutoSave" 
Under the Save tab of the Options Dialogue, you will see settings for Project’s AutoSave XE "AutoSave"  feature.  XE "Options Dialogue:AutoSave" 
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By checking the “Save every” checkbox, you can enable AutoSave XE "AutoSave" . Project will automatically save your current work as frequently as you specify in the corresponding minutes field (the default is 10).
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When you activate AutoSave XE "AutoSave" , a “Prompt Before Saving” checkbox will become available. If you clear this box, Project 2007 will not prompt you when it Auto Saves. If you leave the check in this box, you will be prompted every time your current work is Auto Saved.

Of course, AutoSave XE "AutoSave"  is a very useful feature when working with extensive and important Project files. In the case of a computer crash or power failure, this feature can prevent you from losing hours of work.

Setting Calculation Options

The Calculation tab of the Options dialogue will come in handy if you want to change how Project calculates time and costs. This can also be useful if you don’t want Project to calculate costs or time automatically (or at all).  XE "Options Dialogue:Calculation tab" 
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By selecting the appropriate radio buttons, you can specify if project should calculate automatically or manually. With automatic calculation, time and costs will be computed automatically when factors influencing these values are entered or changed.

Under the manual setting, these calculations will occur only when you take a specific action (such as clicking the Calculate Now button). You can also specify if only the currently active project, or all open projects will be calculated.

Setting Security Options

The options under the Security tab can be useful for removing personal information from the file properties (such as the “Remove personal information from file properties on save” check box).  XE "Options Dialogue:Security tab" 
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The Macro Security button will provide a dialogue with options pertaining to the security and use of macros in Project 2007.  XE "Options Dialogue:Macro Security" 
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Macros are small code modules (programs) that can carry viruses (malicious program instructions). Macros can be extremely useful for some tasks; however, because of the dangers associated with them, macro security is an important subject. For now, the default macro security setting of High will be fine.  (There will be more on this subject of macros in the Project 2007 Expert manual.)
The Interface Tab and Scheduling Options
The Interface tab of the Options dialogue is in keeping with our previous discussions of interface customization and changing Project’s appearance. Under the interface tab, you will see a set of options for enabling indicators and option buttons.  XE "Options Dialogue:Interface tab " 
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An Option Button is a type of control that appears when you modify a task. These buttons often appear when Project must use the “Duration = Work / Units” equation.  XE "Options Dialogue:Option buttons" 
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With the check boxes under the Interface tab (shown above), you can specify what types of actions will invoke option buttons.

There are also options under the Interface tab for displaying (or not displaying) the Project Guide XE "Project Guide"  panes and for using custom content with the Project Guide.  XE "Options Dialogue:Project Guide " 
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Finally, under the Schedule tab you will see options for specifying how your tasks will be scheduled, how your tasks will adhere to constraints, and if new tasks will be effort driven by default.  XE "Options Dialogue:Scheduling options " 
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You can also deactivate the Auto Link feature (automatic linking of tasks that are moved or inserted) by clearing the corresponding checkbox.  XE "Options Dialogue:AutoLink " 
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Using the Scheduling options drop lists, you can also change the time units that duration and work are entered in.

[image: image75.png]Scheduling options for ‘Project1’

New tasks; Start On Project Start Date

Fon = srtared Tars
jorkis entered in Hours

Default ask type: Fixed Units

<2l

<





Once again, to make your option changes global, click the Set as Default button.
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Section 1: Review Questions

1. The Gantt chart XE "Gantt Chart"  view shows…
A. The graphical representation of a task’s duration
B. Links between tasks
C. Sub Tasks
D. All of the above
2. The Tracking Gantt XE "View Commands:Tracking Gantt"  view will show you…
A. Task durations
B. Baselines

C. Critical Path
D. All of the above

3. Which of the following is true?
A. Using the Zoom button can change the timescale XE "" 
B. You cannot add additional tiers to the timescale XE "" 
C. Changing the timescale XE ""  will always increase the duration of tasks
D. None of the above
4.  A bar in the Gantt chart XE "Gantt Chart"  represents…
A. A resource
B. A cost

C. The duration of a task
D. All of the above
5. To format a particular task’s Gantt chart XE "Gantt Chart"  bar you should…
A. Double click on the task name in the task entry list
B. Double click on any task in the Gantt chart XE "Gantt Chart" 
C. Double click on the particular bar corresponding to the task
D. Double click in an empty area of the Gantt chart XE "Gantt Chart" 
6. To modify entire categories of bars in the Gantt chart XE "Gantt Chart"  you should…. 
A. Double click on the task name in the task entry list
B. Double click any task in the Gantt chart XE "Gantt Chart" 
C. Double click an empty area of the Gantt chart XE "Gantt Chart" 
D. None of the above
7. A text box can be used to…
A. Add a comment about the current Project
B. Provide information about a particular element in the Project
C. Enhance the appearance of the Gantt chart XE "Gantt Chart" 
D. All of the above
8. The Project user interface consists of….
A. The menus, toolbars, windows, and dialogue boxes that allow you to interact with the Project program
B. A special dialogue box for customizing the Gantt chart XE "Gantt Chart" 
C. Something that cannot be modified in any way
D. A view that shows resource driven tasks

9. Which parts of the user interface can be customized?
A. Menus
B. Toolbars
C. The menu bar
D. All of the above
10. When you activate AutoSave XE "AutoSave" , Project will…
A. Save your file every time you make a change or edit it
B. Save your file every time you open another application
C. Save your file automatically when you close Project
D. Save your file regularly based on a time period that you specify.
	Check your answers online at www.microsofttraining.net/?
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	Any other questions? Online support forum and knowledge base

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft certified trainers


Section 2: Advanced Topics

In this section you will learn how to:

· Set fixed duration tasks
· Modify fixed tasks
· Add hyperlinks
· Use the Tracking toolbar
· Enter costs
· View costs
· Manually update costs
· Use fixed costs
· Use cost resources
· Change currency
· Use cost rate tables
· Understand WBS codes
· Assign WBS codes to tasks
· View the WBS code

· Define a WBS code

· Import a file
· Export a file
· Use custom maps
· Export a Gantt chart XE "Gantt Chart" 
Lesson 2.1: Tasks

If you’re an advanced user, you’re probably pretty familiar with creating tasks, assigning resources to them, and updating work. In this lesson, we’re going to cover some task operations that you may not be so familiar with.
Setting Fixed Duration Tasks
As you probably already know, there is more than one task type in Project. In the Task XE "Tasks:Task Information"  Information dialogue, you can see the three task type options that are available.

[image: image78.png]Task Information

=3 | e | o
-~

Cantantak

Deadine: A

Consanttyee, [ 5o0m s Pl =
e | E—
Caonder

i
wescode

Eared yalus method

[ ttark task as miestone.

Advanced

Duration: [ 187

Constraint date: [NA

Effort driven

Notes, Custom Filds

©





The following table provides a brief summary of how the task types work.  XE "Tasks:Task Types" 
	Task Type
	Explanation
	Must be Effort Driven?

	Fixed Duration
	Duration for these tasks will not change.
	No

	
	
	

	Fixed Units
(Default Type)
	This task’s units will remain constant.
	No

	
	
	

	Fixed Work
	This task’s work will remain constant.
	Yes


The default task type is Fixed Units. This means that if, after your first resource assignment, you change the amount of resources dedicated to the task, the task duration will change. 
If you change the task type to fixed duration, however, either the work for the task or the units must change when you assign additional resources. This is based on the Project equation:


[image: image79].

Since Duration will remain fixed, assigning additional resources to a task means that either the amount of Work required for the task must increase, or the assigned units for each Resource must decrease. 

For example, assume that we have a fixed duration of 40, work equal to 80, and resources units equal to 20 (4 resources at 5 units each). If we assign another resource, the work/units part of the equation will get smaller because you will be dividing by a larger number (80/25 < 80/20). 

Since the duration is fixed, Project must deal with either units or work, but Project can’t allow the work/units part of the equation to get smaller, because if it does, work/units will not equal duration.
As a result, when additional resources are added, project can either increase the work required for the task or decrease the units for each resource so the total units for all resources remains the same. In our example, 40 = 80/20 but now the 20 units is 5 resources at 4 units rather than 4 resources at 5 units.
Modifying Fixed Tasks
When you modify a task that is fixed, you must take into account the effect on other elements involved in the task scheduling equation. When you look at the following table, keep the Duration = Work / Units equation in mind.  XE "Tasks:About Fixed" 
	Task Type
	If you change…
	Project recalculates…

	Fixed duration
	Units
	Work

	
	Duration
	Work

	
	Work
	Units

	Fixed units (default type)
	Units
	Duration

	
	Duration
	Work

	
	Work
	Duration

	Fixed work
	Units
	Duration

	
	Duration
	Units

	
	Work
	Duration


As an example, let’s say that we have a Fixed Work task that involves a single resource. If we decrease the number of resource units assigned, the resource will have to work longer (increase duration) to accomplish the fixed amount of work.
If we decrease the duration, the resource units must increase to achieve the fixed amount of work required in the reduced time. The parts of the equation that are not fixed will adjust to achieve balance depending on what is changed.
For the default Fixed Units tasks, adding a resource can shorten the duration. The task requires a fixed amount of units to complete the work based on its first resource assignment. If you assign more resources, the work will be done faster. (In other words, if the work requires fixed amount of units and you assign twice as many, the work will get done twice as fast).
Fixed Duration tasks are a bit different. Because the Duration cannot change, some other term in the equation must adjust to compensate if the work or resources is increased.  Summary tasks, for example, are considered fixed duration, because their length depends on how long their subtasks take.

Adding a Hyperlink to a Task
In Project 2007, it is possible to link your tasks to information stored elsewhere, such as a file on your computer, an Internet site, or a site on your company’s intranet.
One way to create a hyperlink XE "Hyperlinks"  of this type is to use the Task Notes tab in the task information dialogue.  XE "Tasks:Adding hyperlinks" 
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Just type the URL of the site into the task notes and it will appear as a hyperlink XE "Hyperlinks" . If you display the Task Notes and click the hyperlink XE "Hyperlinks" , the Web site will open in your browser.

You can also attach a hyperlink XE "Hyperlinks"  by selecting the task, then clicking the Insert menu and choosing Hyperlink. 
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When you perform this command, the following dialogue will open:
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In this dialogue, you can use the navigation controls to create a link to a file or folder on your computer; or you can specify a web location for your hyperlink XE "Hyperlinks" . Whatever you enter into the “text to display” field will be the text of the Hyperlink.
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When you add a hyperlink XE "Hyperlinks"  this way, a hyperlink XE "Hyperlinks"  icon will appear in the task indicator field. If you click on the icon, the link will open. If you let your mouse pointer hover over the icon, a comment box will pop up showing the hyperlink XE "Hyperlinks"  “text to display.”  

The following table summarizes the differences between these two methods of creating hyperlinks.  XE "Tasks:Notes vs. Hyperlinks" 
	Insert Hyperlink Command
	Task Notes

	Can browse to files on your computer or network, or specific places in those files (such as a section in a Microsoft Word document).
	Cannot browse or link to files.

	Can link to e-mail addresses, Web sites, or Intranet sites.
	Can link to Web or intranet sites; must know the address as there is no Browse function.

	One per task.
	Can list as many hyperlinks as you want.

	Can click the task indicator ([image: image84.png]


) to jump to that location.
	Task indicator ([image: image85.png]


) shows that a note is attached, but you must manually open Task Information and click the hyperlink XE "Hyperlinks"  in the Notes field.


Using the Tracking Toolbar
The Tracking toolbar lets you update the scheduling and completion levels for tasks, and moreover, provides tools for tracking a project’s progress.  XE "Toolbars:Tracking"   
To enable the Tracking toolbar, click the View menu, choose Toolbars, and click the Tracking option. The tracking toolbar will look like the following.
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The table below provides a brief description of the tools on the tracking toolbar.

	[image: image87.png]



	View your project’s statistics.
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	Set the task’s Actual Start Date as the scheduled start date. This will also record Actual Duration completed to the current date (or the status date XE "Status Dates" , if one has been specified).
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	Reschedule work for the current date (or the status date XE "Status Dates" , if one has been specified).
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	Add a progress line. (These will be covered in detail later on.)
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	Set this task as Not Started.
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	Set the selected task as 25% complete.
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	Set the selected task as 50% complete.
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	Set the selected task as 75% complete.
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	Set the selected task as 100% complete.
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	Shows the Update Task form for the selected task.
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	Set a Reminder.
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	Display the Collaborate toolbar.  XE "Toolbars:Collaborate" 


Lesson 2.2: Project Costs

To a large extent, managing a project involves two main tasks: managing time and managing costs. This lesson will deal with Project’s cost management features. You will learn how to change currencies, enter costs, how to view costs, and how to update costs. You will also learn about fixed costs and about one of Project 2007’s new features, cost resources.  
Setting Currency Options
Before we begin our discussion of costs in Project, we should talk a little bit about currencies (after all, pretty much any cost is measured in some type of currency).  XE "Options Dialogue:Currency options" 
To set the currency for a project, click Tools, followed by Options, and then click the View tab in the Options XE "Costs:Setting currency"  dialogue.
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With the options shown above, you can set up the currency type for the current project. The default currency is US dollars, with the symbol $ and two digits after the decimal. To change the currency, display the Currency drop list.
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You can scroll through the currency list to find the currency option of your choice. You can use the other currency options to change the symbol that is used, as well as the placement of the symbol relative to the number.
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When you have set up your preferred currency for the Project, click OK in the Options dialogue to implement your choice.

Entering Costs
There are a few different ways to enter costs in Project 2007. To explore these, let’s look at a simple example.  XE "Costs: Entering" 
In the following project, you will see one simple task called “Build the pool” that has a duration of two weeks.
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The resource sheet view tells us that there are three resources available: Mike, Bill, and Janet.
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As you probably already know, each one of these resources can have costs associated with them. There is a Standard rate and an Overtime rate field for each one of these work resources. You can think of these fields as the standard and overtime cost for the corresponding resource.

To enter these costs, type them directly into the standard rate and overtime fields respectively. 

[image: image104.png]Resource Name Type Material Label Intials Group | Max.Units | Std. Rate
Mike Work M 100% 32200

] Work B 100
danet Work 4 100 00/





Notice that for the last resource (Janet) a value of 800/w is entered. This means that the cost for the resource named Janet is eight hundred dollars (or whatever currency unit you specified for the project) per week. If you just entered the value 800 without the /w, Project would assume that you mean 800 per hour, as hour is the default pay rate unit. You can enter resource costs on an hourly (/hr), weekly (/w), or yearly (/y) basis, as you see fit. 

You can also double click on a resource to reveal the Resource Information dialogue. Under the Costs tab you will see options for entering Standard and Overtime costs.  XE "Costs:Standard" 
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The same rules for entering costs apply here just as they did for the Resource sheet view discussed above. However, under this Costs tab, you can specify changing costs as time progresses.  XE "Costs:Overtime" 
For example, If Mike gets paid 20 % more after a specific date, we can enter the date in the Effective Date field, and then enter the percentage increase (or actual cost value) in the Standard Rate field.  XE "Costs:Variable" 
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When you press the Enter button, the percentage will turn into a cost value based on the preceding cost plus the percentage change. 

If his cost decreases after a certain date, you could enter a negative percentage in the standard rate field.
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You can apply multiple cost changes and their corresponding effective dates to a particular resource. You also use this technique to apply changing costs to several different resources. 

You will also notice a Per Use Cost field under the Costs tab.
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This is where you would enter costs on a per use basis. For example, a particular type of machine may cost $500 per use.  XE "Costs:Per use" 
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This field is also available in the resource sheet view.

Finally, you can use the Cost Accrual drop list near the bottom of the Costs tab to specify if costs will be applied at the beginning or end of the task, or evenly throughout the duration of the task (prorated).  XE "Costs:Accrual" 
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Using Cost Rate Tables

You should notice that there are five tabs across the top of the table of cost information that we discussed above.
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You can click on each tab and setup from one to five different resource cost tables. When you click the OK button in the dialogue, these Cost Rate tables will be preserved along with the other resource information.  XE "Costs:Cost Rate tables" 
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When a resource is assigned to a task, you can choose any of the resource’s cost rate tables for the task. This allows you to model situations where a resource may be paid a different rate depending on the type of work (task) in question (for example, an office rate vs. a field rate). You can also model situations where a resource’s cost changes over time.

If you do not specify a particular cost rate table, the default is table (tab) A.
For an example, assume that the resource named Mike is assigned to the task of building the pool.
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If you switch to Resource Usage view (View - Resource Usage) and double click on a particular task (Build the Pool in this example), you will see the Assignment Information dialogue.
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In the Assignment Information dialogue, you can specify the cost rate table of your choice from the Cost Rate Table list provided.

About Fixed Costs
Sometimes there are costs that are not associated with a particular work or material resource. Take the “Build a pool task” for example, and assume that each swimming pool requires the purchase of a filtration system for 500 dollars. This means that there is an additional, fixed, 500 dollar cost for each pool that is built.  XE "Costs:About Fixed" 
To enter this cost, choose the View menu followed by the Table option, and then click the Cost option.
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In the Cost view, you will see a field for fixed costs and total costs.
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If you enter 500 as a fixed cost for the task (for the pool filtration system) you will see the total cost for the task rise accordingly.
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About Cost Resources
Cost Resources XE "Resources:Cost"  are a convenient new addition to Project 2007. Like a fixed cost, a cost resource has no relationship to the work required for a task or the amount of work resources applied to the task.  XE "Costs:As resource" 
A cost resource is different from a fixed cost in that you can only enter one fixed cost for a task. This means that if you have several fixed costs for a single task, they must be added together and entered as a lump sum. Project 2007’s cost resource feature allows you to specify as many different fixed costs to a project as you like.

To create a cost resource, display the resource sheet view (View - Resource sheet), enter a name for the resource, and click the Type field to display the Type field’s drop list. 
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Select the Cost option from the Type drop list and you will have created a cost resource. Now, switch to Gantt chart XE "Gantt Chart"  view, select a task, and then display the Assign Resources dialogue (Tools - Assign Resources).
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In the Assign Resources dialogue, choose your cost resource (pool chemicals in this example) and enter a monetary value associated with your cost resource. Remember, you can assign as many different cost resources as you like to a task.
Viewing Costs
To view the total cost for your tasks, start from a Gantt chart XE "Gantt Chart"  view with the Task Entry list (Views - Table - Task Entry) and then choose the View menu, followed by Table, followed by the Cost XE "Costs:Viewing"  option.
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In the resulting view, you will see a list of your project’s tasks and their corresponding total costs. The value of the total cost for a task will include any fixed costs or cost resources that have been applied.
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You can also see the total costs for your resources by displaying the Resource sheet view (View - Resource Sheet), and then once again selecting the Cost Table XE "View Commands:Cost Table"  (View -Table - Cost). This action will display cost information for all of the resources in your project.
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If you wish, you can use the Group By drop list on the toolbar to organize your cost views.
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If you choose the Resource Type option from the Grouping by list, your resource costs will be grouped according to their respective resource types.
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Here are the results organized by resource type.
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If you want to quickly view the total costs for the entire project, choose the Project menu, followed by the Project Information option.
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This will display the Project Information dialogue. In this dialogue, click the Statistics button to see the cost information.

[image: image127.png]Sartdater  [FiS122006

Einich dae:

Schectle from: [ Project Start Date
Altasks begin s soon as posile.

Enterprise Custom Fields

Custom Fild Name

==

Current date:
Status date:
Calendar

riarity:

Frioj22/06
WA
Standard

E

Vale





Here you can see the current total costs, the current actual costs, and the remaining costs for the project.
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Remember, you can customize your cost views to some degree by adding or removing column fields. For example, look at the following Task Entry/Gantt chart XE "Gantt Chart"  view.
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Now, if we switch to a cost table view (View - Table - Cost), we will see something like the following.
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Now, if you click the View menu followed by the Task Usage option, you will see a screen like the one shown below.
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In this task usage/cost table view, you can see a break down of the Actual costs, the Total costs, the Baseline and the Variance, for each task and its corresponding resources.
Manually Updating Costs

To manually update costs, you should first turn off the default automatic cost updating. (With automatic cost updating, when you enter a percent complete for the task, the actual cost will be calculated by Project.)
First, click the Tools menu, followed by the Options menu item. In the Options dialogue, choose the Calculation tab. Under the Calculation XE "Costs:Updating manually"  tab, clear the “Actual costs are always calculated by Microsoft Office” box.
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Click the OK button to implement the settings. Now, you will have access to the actual cost fields to be able to change them accordingly. 

To enter an actual cost, choose View - Table – Cost.
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In the cost table, manually update the cost by entering a value directly into the Actual field.
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Here, the total cost has been recalculated from the manually entered actual cost and the cost remaining.
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Remember, if you want to switch back to automatic calculation of actual costs, you must recheck the appropriate box in the Calculation tab of the Options dialogue. 
Lesson 2.3: The Work Breakdown Structure Code

By now, you’re probably pretty familiar with creating summary tasks and subtasks. What you may not know, however, is that Project adds a secret number to your outlined tasks. This number is called the Work Breakdown Structure Code XE "Work Breakdown Structure Code:What is?" , or WBS, and it identifies each task in its outline order.
Understanding the WBS Code
To understand the significance of the WBS code, take a look at the following example project.
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Here you can see two sets of subtasks, one within the other.

The WBS coding for these tasks could be:


[image: image137]
You can see that the WBS code is the number assigned to each task to identify its position in the task outline.This ordering system helps to create a very organized planning process. It can also help you identify critical points in your project. 
Assigning a WBS Code to a Task
Although you can use Project’s WBS Code features to maximize your efficiency, you don’t have to worry about assigning the code to tasks. Project assigns and updates a default WBS code to tasks as you create and update them.  XE "Work Breakdown Structure Code:Assigning" 
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Viewing the WBS Code of a Project
Up to this point, we haven’t actually seen this mysterious code displayed in Project. The easiest way to view the WBS code is to first enter a table view, such as Gantt chart XE "Gantt Chart"  or Resource Sheet, and then right-click on a column header and choose the Insert Column option.  XE "Work Breakdown Structure Code:Viewing" 
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When you perform this action, a Column Definition dialogue will appear. From this dialogue, choose WBS for the field name.
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Note that you can also choose the field title, alignment, and width in this dialogue.
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If you wish, you can click the Best Fit button to have Project fit the column to its contents. Once you click the Best Fit or OK button, the new column will be inserted to the left of the column you initially right clicked on.
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Customizing the WBS Code
Although Project automatically assigns a WBS code to all tasks, you do have the option of creating your own WBS ordering scheme.

 To do this, click the Project menu, choose WBS, and click Define Code.  XE "Work Breakdown Structure Code:Defining" 
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Performing this action will display the following Code Definition dialogue:
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To create a WBS code, enter a code sequence, code length, and separators for each level that will be required for the WBS code in your Project. Take the following WBS code structure as an example.


[image: image145]
The implementation of this code in the Code Definition dialogue would be:
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You can see a preview of your custom WBS code in the Code Preview field at the top of the dialogue. To apply your code to the tasks in your project, click the OK button.

The following image shows the tasks ordered by the custom WBS code defined on the previous page.
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You can see that the tasks are still in the same order, although they have been identified differently. If we move tasks, however, we will have to use the WBS menu to re-number our tasks.  XE "Work Breakdown Structure Code:Renumbering" 
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Lesson 2.4: Importing and Exporting Files

Another important part of Project 2007’s functionality is its ability to work with different types of files. In this lesson, we’re going to look at how to import files (bring them into Project) and how to export files (send them out from Project).

Importing a File
In Microsoft Project, the import XE "Project Files:Importing"  wizard opens automatically when you try to open a file type that does not begin with “mp” (Microsoft Project).
 In the following example, we’re going to click the File menu and choose Open. Next, from the Files of Type menu, we’ll choose all files so we can see all of the files available in the given folder.
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Here we have selected an Excel spreadsheet file (Resources.xls). To invoke the import wizard we simply have to click the Open button.
The first dialogue window of the import wizard is essentially just a greeting. To continue, click the Next button.
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In the next dialogue of the import wizard, you have the choice of selecting an existing map or a custom map. This map will tell Project how to interpret your data. For this example, we’re going to use an existing map.
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Once you make your map selection by clicking the appropriate radio button, you can click Next to continue. In the next dialogue box, we will select the type of existing map that we want to use. Since we are going to be importing a list of resources from the Excel spreadsheet, we will use the “Resource Export Table” map.
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Once we click Next, we’ll be asked how we want the file to be imported. You can create a new project, attach this information as a separate project, or merge it into the current project. 
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Now, we’ll be asked what kind of data we want to include. Since we selected a resource map in the previous steps, the Resources box is checked by default.
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When you click Next, the following stage of the wizard will be displayed, where you will be asked to map fields. 
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When you examine the dialogue shown on the previous page, you will see that the entries in the middle part of the window are red. This means the fields in our worksheet don’t match up with the fields on the map we selected and Project doesn’t understand them.
To fix this, we’ll choose the worksheet with the data we want from the “Source Worksheet Name” drop list.  In this example Sheet1 is going to be the source of the import data.
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When we select the source worksheet, we will be able to map each field to its Project equivalent.
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You will notice in this example that one of the Excel fields (Hourly Wage) is not mapped to Project. If you click on the field that displays “(not mapped)” in red, you can choose the project field that you want to map to from a drop list.
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For this example, we will choose Standard Rate from the list.

Once we’ve completed our mapping, you’ll see that the fields are no longer in red, and that a proper preview will appear at the bottom of the dialogue.
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When we click Next, we’ll be in the final stages of the import process.

[image: image160.png]Import Wizard - End of Map Definition.

Congratulstions!

The Import Wizard has al the information it needs to finish
importing your data.

Clck Finsh to complete the operatian.

O clck Save Map i you would ke to save these wizard
Settings a5 a map to Use agan n the future.





In this final stage of the wizard, we will click Finnish to complete the import. (Note that you can also save the import map that you created for use in the future.)
Now that we have finished the import, we can switch to Resource Sheet view to see the results.

[image: image161.png][}

1

Resource Name
Bob Snith
Jahn James
LisaLeeds
Linda Smith
dm Green
Ancrew Megle

Type
Work
Work
Work
Work
Work
Work

Material Label

Intials: Group
B
W
w
Ls
5
am

Max. Units.

100%
100%
100%
100%
100%
100%

Std. Rate:

925 00
53000
40,00
528,00
925 00
52000




Here is the data that we imported. Now that you have it in Project, you can edit it as you see fit.

Here is the data in its original Excel spreadsheet.
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Exporting a File
Of course, Project 2007 will also help you export XE "Project Files:Exporting"  data to file formats suitable for other programs. If you try to save a file using an extension that does not start with “.mp,” the Export Wizard will launch.
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Note in the image shown above that the “Save as Type” is an Excel workbook and the extension on the filename is .xls. Remember, we are saving this file from within Project.
When we click the Save button the first screen of the Export wizard will appear.
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As before, this first screen in the wizard is little more than a welcome dialogue. Just click Next to continue. The next step will allow you to specify what you want to export. Typically, the option you choose will be Selected Data.
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When you click Next in this dialogue, the next stage of the wizard will appear. Once again, you will be asked whether you want to use an existing map or a new map. For the purposes of this example, we will choose to use an existing map.
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When you click the Next button, you will be asked which one of the existing maps you want to use.

[image: image167.png]Export Wizard - Map Selection

Choase a map for your datai

"Wha Doss What" repart

Cost data by task.
Default task iformation

Earned valus informatian

Export to HTML using standard template
Resource "Export Table" map

Task ‘Export Table" map.

Task and resaurce PivotTable report
Task st with embedded assignmert raws
Top Level Tasks st

<t ] (o> ) o [ conel





For this example, we will use the “Who Does What” map to prepare a list of resources and their tasks as an Excel spreadsheet. When you are ready, click Next to continue.

Next, you will be asked what type of data we want to include. If you’re using an existing map, it is best not to change these settings.
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When you click Next, you will be asked to confirm the mapping. Usually, you won’t have to change these settings either.
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At this point, once you click Next, you will have the options to save your export map or finish the export, just like the Import wizard.
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In this example, we will click the Finish button to export the data to a spreadsheet. Now, we have an Excel workbook listing various resources and their assignments.
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Using Custom Maps
When importing files XE "Project Files:And custom maps" , Project’s pre-defined maps can be really useful. However, we saw that we had to take some extra steps to get the pre-defined map to work properly when we imported a file.

To avoid all of this, you can simply choose to create a new map when importing a file. To do this, use Project to open the file that you want to import from as before.

Once again the Import Wizard will start, but this time, when you reach the stage shown below, choose the New Map option instead of the Existing Map option.
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When you do this, the import wizard step that requires you to choose data types will have no options selected. You will have to choose what data you want to import.
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Once you choose your data type, you must choose the data source location (in this case it is Sheet1) and then map the various fields, like we did before when modifying the pre-defined map.
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From this point, just click Next to walk through the rest of the wizard as before. You can click Finish to perform the import (or export) with the information you have given Project. 

If you often use the same mapping sequence, you may want to save your map on the last step of the Import/Export wizard.
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Clicking this Save Map button will open the following dialogue:
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Here you can enter a name for your map, and click the Save button to save it. Once you have saved your map, it will appear in the Existing Maps list when you are importing or exporting a file.
Exporting a Gantt Chart XE "Gantt Chart" 
The exporting methods we just learned about are good for exporting resource lists, task outlines, and other tables. But, what if you want to export your Gantt chart XE "Gantt Chart" ? 
You can copy your Gantt chart XE "Gantt Chart:Copying as picture"  as a picture by clicking the Copy Picture XE "Copy Picture Wizard"  button ([image: image177.png]


) on the standard toolbar; or by clicking the Report menu and choosing the Copy Picture option. Either of these methods will open the following dialogue:
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In this dialogue you can choose how you want to save the image (for screen, for a printer, or as a .Gif image file), the rows you want to copy, and the timescale XE "" . Once you click OK in the dialogue, a copy of your screen will be placed on the clipboard, ready for you to paste in any application.
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Section 2: Review Questions

1. The basic equation that Project uses for scheduling tasks is…
A. Work = Duration + Costs
B. Duration = Work / Assigned units
C. Cost = Duration / # of Resources
D. None of the above
2. A hyperlink XE "Hyperlinks"  can link a task to… 
A.  A Word document
B.  A spreadsheet 
C.  An external web page
D.  All of the above
3. The standard rate for a resource is a…
A. Fixed cost
B. Cost resource
C. Material cost
D. Work related cost
4. How many fixed costs can you have per task?
A. 1
B. 3 or less
C. You can’t have any
D. As many as you like
5. How many cost resources can you assign to a task?
A. 1
B. 3 or less
C. You can’t have any
D. As many as you like
6. A cost rate table allows you to…
A. Change how costs occur over time for a given resource
B. Choose from a selection of cost rates when you assign a resource to a task
C. Always find the most inexpensive way of completing a task
D. Change the total work required to complete a task
7. The “WBS” in WBS code stands for…
A. Work Breakdown Structure
B. Working Basic Service
C. Web Browsing Service
D. Work By Selection
8. To see the WBS code for a task, you can…
A. Display the Gantt chart XE "Gantt Chart"  view
B. Display the WBS view
C. Insert the WBS column into the Task entry list
D. None of the above.
9. To import an Excel file into Project 2007 you should… 
A. Use the Import Menu
B. Use the Import button
C. Open the Excel file using the Open dialogue in Project
D. Any of the above
10. To export project data to an Excel file you should….
A. Save the Project as an Excel workbook using the Save As dialogue from within Project
B. Use the Export Excel Data command
C. You cannot export data to an Excel file.
D. None of the above.
	Check your answers online at www.microsofttraining.net/?
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	Any other questions? Online support forum and knowledge base

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft certified trainers


Section 3: Finishing Your Project

In this section you will learn how to:

· Use the Drawing toolbar
· Draw shapes 
· Draw lines
· Draw arrows
· Change the order of objects
· Modify drawing properties

· Cycle the fill color

· Attach a drawing to a task

· Update tasks
· Update the project

· Apply custom filters

· Display progress lines

· Interpret progress lines

· Edit progress lines

· Format progress lines

· Use the Project Guide XE "Project Guide"  to track progress

· Understand status indicators

· Track overdue tasks

· Track completed tasks

Lesson 3.1: Adding a Drawing

There may be times when you want to enhance the appearance of your Project data with shapes, arrows, or annotations. We have already discussed this general idea when we talked about Text Boxes (see Lesson 1.2). Now you will learn how to use the Drawing toolbar to draw lines, arrows, and other shapes.

Using the Drawing Toolbar
Before you can use the drawing toolbar XE "Toolbars:Drawing" , you must first display it. To do this, first click the Insert menu and then click the Drawing option. 
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You can also right click on empty space in the toolbar area of the screen and then select the Drawing option.
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The Drawing toolbar will appear roughly in the middle of your screen.
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Like the other toolbars, you can dock the drawing toolbar XE "Toolbars:Drawing"  on the top, bottom, or sides of the screen.
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The main tools (shapes, lines, and arrows) on the drawing toolbar XE "Toolbars:Drawing"  are all used in a similar way.

First, click on the tool XE "Drawings:Basics of"  of your choice. Your mouse pointer will turn into a crosshair. Next, use your mouse to drag out the shape or line on the Project screen to roughly the dimensions that you require. 
When you release your mouse button, the shape will appear.
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There is also a drop list available on the toolbar under the word Draw.
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This drop list is used for moving and manipulating shapes that you have added to your project. (There will be more on ordering and editing drawing objects in the next lesson.)  XE "Drawings:Ordering" 
At the bottom of the drop list, you will see an option called Edit Points. You can use this option to drag or skew the points of a polygon so that its shape changes.  XE "Drawings:Edit Points command" 
You will also see a down arrow in the upper part of the toolbar. If you click this, an option will appear called Add or Remove Buttons. Under this option, a menu will appear.
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The first (the Drawing option) will reveal a list of the buttons that you can add to or remove from the toolbar. To toggle the check on or off, just click on the option.
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The other option, Customize, will open the Customize dialogue as shown here.  XE "Toolbars:Customizing" 
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You can use this dialogue to add additional controls to the Drawing toolbar. (See Lesson 1.3)

Finally, you can close the drawing toolbar XE "Toolbars:Drawing"  by simply clicking the X in the corner.
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Drawing Two Dimensional Shapes
It is a very simple task to draw a basic two dimensional shape on your Project screen. First, open Project and display the Drawing toolbar.  XE "Drawings:2D Shapes" Next, click on the Shape button of your choice from the drawing toolbar XE "Toolbars:Drawing" .
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When you click a shape, your mouse pointer will turn into a cross. At this point, you can use your mouse to drag out the basic dimensions of the shape.
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When you release your mouse button, the shape will appear on your screen. 
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Now, if you double click on the shape you added, you will see the following Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue.
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Under the Line & Fill tab, you can specify the thickness and color of the lines that your shape is drawn with. You can also specify a color and pattern to fill your shape with. The Preview area will show you what your shape currently looks like.  XE "Drawings:Coloring" 
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Under the Size & Position tab, you can attach your shape to a task or timescale XE "" . You can also enter the Height and Width of your shape directly in the fields provided.  XE "Drawings:Changing size" 
When you have set up the options for your shape, click the OK button to implement them.

Here is the same shape as before, but with some fill color, a pattern, and line thickness added.
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If you single click on a shape, it will be surrounded by small black squares at the corners and sides.
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If you drag one of the small black squares at the top, bottom, or sides of the shape, the shape will be stretched along the dimension that you drag (vertically or horizontally).  XE "Drawings: Resizing" 
If you drag one of the black squares in the corners, the shape will be resized in both dimensions (scaled). You can use this technique to enlarge or shrink a shape.

To move a shape, just click and hold your mouse button on the shape, and drag it to its new position.  XE "Drawings:Moving" 
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To remove a shape from the screen, single click to display the small black squares, and then press your Delete key. Alternatively, you can right click on the shape and choose the Delete option from the pop up menu.  XE "Drawings:Deleting" 
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Drawing Lines
To draw a line in Project, first click the line icon on the drawing toolbar XE "Toolbars:Drawing" .
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When you do this, your mouse pointer will turn into a cross.  XE "Drawings:Lines " To draw the line, drag with your mouse in the direction that you want your line to follow. When you release your mouse button, you will see a line on the screen.
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As with the two dimensional shapes, you can double click on your line to display the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue, or you can single click on the line to display a small black square at each end point of the line. If you drag one of these small black squares, you can lengthen or shorten the line, or rotate it around the other end point. 

If you click and hold your mouse button on the line itself, you will be able to relocate it by dragging it with your mouse.

To remove a line right click on it and choose Delete, or single click on it to show the black squares, and then press your Delete key.  XE "Drawings:Deleting" 
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Drawing Arrows
Essentially, drawing arrows is exactly the same as drawing lines. First, click the arrow icon on the Drawing toolbar.  XE "Drawings:Arrows" 
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Next, use your mouse (now with a cross pointer) to drag in the direction that you want the arrow to point in.
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You can invoke the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue by double clicking on the arrow. You can resize and reposition your arrow the same way we moved and resized lines. You can also delete an arrow in the same way that you would a line.

Drawing Polygons

Drawing a polygon is a little different from drawing other two dimensional shapes. To start, first click the Polygon icon on the drawing toolbar XE "Toolbars:Drawing" .
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As usual, your mouse pointer will turn into a cross, but this time, you do not drag out your shape in the usual way.  XE "Drawings:Polygons" 
With the polygon tool, click on your Project screen to specify an anchor point. Next, release your mouse button and click in another spot on the screen to create a second anchor point. When you do this, a line will automatically appear between the two points. If you click again to create a third anchor point, a line will be drawn joining the second point to the third. In this way, you can draw pretty much any irregular shape, as long as it is constructed with straight lines.

[image: image206.png]S Gprpentert Carpenter2,Carpente

Carpenter

/

@ Landscapers[75%]




You can invoke the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue and resize and reposition a polygon, using the same methods you saw before for two dimensional shapes.

Here is a polygon that has had its outline thickened and filled with a colored pattern.
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 Lesson 3.2: Editing a Drawing

Now that you know about the Drawing toolbar and understand the basics of creating shapes, it is time to learn how to modify your drawings. In this lesson you will learn how to rearrange the ordering of multiple shapes, modify the properties of your shapes, attach drawings to tasks, and cycle through your shapes’ fill colors. 
Changing the Order of Shapes
In the following image, you will see a Project screen with four drawings (shapes) on it that were created from the Drawing toolbar.  XE "Drawings:Ordering" 
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If you want to change the order of these shapes (which shapes appear in front of which), single click on a shape to select it, and then display the Draw menu on the Drawing toolbar.
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You will see four options for changing the relative position of the selected shape. If you choose the Bring to Front option, the selected shape will appear on the top (in front) of the other shapes.
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If you choose the “Send to Back” option, the selected shape will be moved to the back of the pile.
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The “Bring Forward” option will cause the selected shape to move ahead one level. Here is a collection of shapes before using the Bring Forward option. Note that the green oval is selected.
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Here is the same collection of shapes after clicking the Bring Forward option.
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Next, if the Send Backward option is used, the selected shape will move behind the shape that it was in front of.
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Modifying Drawing Properties
To modify the properties of a shape or drawing in Project, right click on the shape in question and select the Properties option from the pop up menu.  XE "Drawings:Properties dialogue" 
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This will display the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue. Here you can adjust the thickness and color of the lines that define the shape, as well as the pattern and color of the shape itself (Line and Fill tab). Your line and fill options are available under drop lists in the fields provided.
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Under the Size and Position tab, you can select one of the Position radio buttons to attach a shape to the timescale XE ""  or to a task XE "Drawings:Attaching to task" .
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As an example, consider the shape shown here.
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You can see that the shape is located under the week of Sep 10/06. Now, we will set the Date field (under the “Attach to timescale XE "" ” radio button) to Oct 10/06.
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When you click the OK button, the shape will move to a new location under the timescale XE "Timescale"  at the date that you specified. (Note: The value in the “Vertical” field represents the distance down from the timescale XE "Timescale"  to where the shape will be located.)
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For an example of changing the properties of a drawing, take a look at the following rectangle.
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Now, we will invoke the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue, and configure the settings as follows.
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Here, we have set the line color to blue and have chosen a thicker line type from the drop lists under the Line area of the dialogue. In the Fill area of the dialogue, we have chosen yellow as a color, and we have selected a solid pattern.

When we click the OK button, our modifications will be applied.

[image: image223.png]Sep10,'08 Sep17,'08

FIS[S M[TWTIF[S[S M[TWITIF[S





Now, if we display the dialogue again, and change the Height and Width under the Size and Position tab to these settings:
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Our shape will be resized according to the values we entered.
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Cycling the Fill Color
When you select a shape in Project, a button that looks like an artist’s palette will be accessible in the Drawing toolbar.  XE "Drawings:Cycling fill color" 
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If you click this button, the shape will be filled with a color.
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If you click the same button again, the fill color will change.
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If you continue to click the button, the shape’s color will change again and again, allowing you to cycle through multiple colors until you find the one that you like for your shape.
Attaching a Drawing to a Task
If you select a drawing XE "Tasks:Attaching drawing to"  in project by single clicking it, an “Attach to task” button will be accessible at the far right of the Drawing toolbar.  XE "Drawings:Attaching to task" 
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If you click this button, you will see the Size & Position tab of the Format Drawing XE "Drawings:Format Drawing dialogue"  dialogue. (You could also display this dialogue by right clicking the drawing and choosing Properties.)
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If you select the “Attach to task” radio button, you can then specify the ID number of a task (the number of the task in the task entry list) to attach the selected shape to the task in question. When you click OK, the selected shape will now be attached to the Gantt bar of the task corresponding to the Task ID you entered.

You can choose which end of the Gantt bar to attach the shape to with the following radio buttons.
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You can also specify a horizontal and vertical distance by using the fields provided. This will be the distance between the specified end of the Gantt bar and the selected shape.
This image shows a basic shape located at zero distance from the right end of a task’s Gantt bar.

[image: image232.png]',




If the Gantt bar is moved or the right end is relocated due to a delay or increase in duration, the shape will move with it.

Lesson 3.3: Updating and Filtering Your Project

One of the main purposes of Project 2007 is to give you a clear picture of exactly where your project currently stands, and how well you are proceeding according to plan. A key part of using Project to your advantage in this regard involves knowing how to update and track your progress. In this lesson, we will go over some of Project’s updating and tracking features.

Updating Tasks
To update an individual task, first select the task by clicking its ID number in the task entry view and then choose the Tools menu, followed by the Tracking option, followed by Update Tasks.
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This will reveal the Update Tasks XE "Tasks:Updating"  dialogue.
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Here you will see a Percentage Complete field, an Actual Duration field, a Remaining Duration field, an Actual Start field, and an Actual Finish field.

If the selected task has started on a date that is different from the original (current) date, enter this new date in the Actual Start field. When you do this, and click the OK button, the start date that you entered will become the new Current Start date, and the task will be adjusted accordingly in the Gantt chart XE "Gantt Chart" .

Here is an image of the task the task corresponding to the Update Tasks dialogue shown above.
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Here we are changing the date to the 15th of September.
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As a result, the current start date now changes to the 9/15/06, and the Gantt bar moves to the right along the time scale accordingly.
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If you enter a new Actual Finish date for the task, the current finish date and the Gantt chart XE "Gantt Chart"  will be adjusted according to this new date. It is important to note, that if you enter an actual finish date, the start date will not change, and the duration of the task will be adjusted to accommodate the new finish date. If you enter an actual start date, however, the duration will not change, and the finish date of the task will be adjusted to accommodate the new start date and the original duration.

Now, let’s look at the other fields in the dialogue.
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If you enter a value in the % complete field, the Actual Duration field and the Remaining Duration field will adjust to reflect this.
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If you enter a value into the Actual Duration field, the % Complete field and the Remaining Duration field will adjust accordingly.
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If you enter a value in the remaining duration field, the % complete field and the Original duration will change accordingly.

In the image below, we add another 1.5 weeks to the remaining duration that is shown in the dialogue above.
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Now, when we click the OK button, the percent complete and the original duration will adjust to this new update.
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The finish date for the task and the Gantt chart XE "Gantt Chart"  will also adjust for these changes.

 As a matter of fact, the Gantt chart XE "Gantt Chart"  bars, and the start and finish dates will adjust for any changes that result in a change of duration or a movement of the task along the timescale XE "" .

Finally, if you click the Notes button in the Update Tasks dialogue, you can add a note to the selected task.
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The note will appear in a small comment box when you let your mouse hover over the note indicator in the task list’s indicator field.
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Updating the Project
Rather than update your project on a task by task basis, you also have the option of updating the entire project at once.

To display the options for doing this, click the Tools menu, followed by Tracking, followed by the Update XE "Project Files:Updating"  Project option.
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Performing this action will display the following dialogue.
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The first radio button in the dialogue is labeled “Update work as complete through.” This means that the tasks in your project will be set as completed according to the current schedule up to the date which you specify in the date field.

Here is an example. Take a look at the following Gantt chart XE "Gantt Chart"  and timescale XE ""  to see a project that is zero percent complete.
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Now, we will specify a date as work completion update point for the Project.
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We choose 10/20/06 as our update completion point. When you click OK, all tasks in the Project will be updated as 100% complete or partially complete up to the date you specified. 
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Now you can see black completion bars indicating the progress so far based on the project completion date that you entered. If you want to remove these updates, just click the Undo button.

In the Update Project dialogue, you have a choice between two radio buttons to specify how the tasks will be updated.
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The first radio button (Set 0% -100% complete) is the default choice. Under this setting, tasks with a duration that contains the completion date will be adjusted to be partially complete accordingly.

Under the second radio button (Set 0% or 100% complete only) tasks that have a duration that contains the completion date will be set to 0% complete. Tasks that finish before the completion date will be marked as 100% complete.
As an example, consider the following project tasks.
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You can see from the timescale XE ""  that the duration of the second task from the top includes the date Sep 23/06.

Let’s set up the Update Project dialogue as follows. Here we specify the completed through date as 9/23/06.
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Now look at the Gantt chart XE "Gantt Chart"  in the following image.
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You can see that the tasks that finish before the 23rd are updated as complete, but the task that has a duration that includes the 23rd is left 0 % complete.
In the bottom half of the dialogue, you will see options for rescheduling uncompleted work. 
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When you specify a date in the date field, any uncompleted work will begin after the specified date. 

Take the following project as an example.
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Here, the completed through date has been set as October 10.
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Now, let’s change the “Reschedule uncompleted work XE "Project Files:Rescheduling uncompleted work" ” date to a later date (10/16/06).
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Now, when you click the OK button, Project will reschedule the uncompleted tasks as required.
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At the bottom of the Update Project dialogue, you will see two radio buttons, one for the entire project and one for selected tasks. If you choose Entire Project, the changes you make will be applied to the all of the tasks in your project that can be influenced by the changes. If you choose Selected Tasks XE "Tasks:Updating selected" , the changes you make in the dialogue will only be applied to tasks that you have selected. 
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Applying Custom Filters
You have probably already seen how to apply filters to tasks in the intermediate manual. Since filtering is a very convenient and powerful way to analyze your project, we will now discuss advanced filtering concepts.
As you know, you can always click the AutoFilter XE "Filters:AutoFilter"  button ([image: image260.png]


) on the toolbar to attach filter drop lists to the top of your Task Entry table columns.

[image: image261.png]E E<OB

[EIEIREYF]E]

(Custom...)
Integration testing
Buid Components
Copture requiements

(Create Documentatian
Desion components

Finsl Meeting with Programers

Fix software as required by test es
et with President

Revise documertation
Print Documertation

Release Softwareta users
Meet wih Presidert

Final Meeting with Programers.

SR H= e tesource Names ,
Tk Wed 178 Tue 1158 Systems Analyst
543days  Fri1n108 | Friseens
2days| Wed 1508 Thu 1008 1
2mons| FA1AI0B Thu3mOG 15 Programmers
20days?|  Fri3708 Thuan7ig
Gdays?  Fi37mE Tue3aNE 16
35days? Wed 9B Set 3208 18
12days?  Set322M8 Thu4M0ms 19
|| 55deysr Tuanons Thuanios 20
1wk Thu221me Wed 2278 Tech Wrter
3days| Wed 207108 Fri 20008 Tech Wrter
dhrs| Tuedmame Tue4r2us
1wk Tuediams  Set 426me
The TuedNB  Tue31NB 23
The Thuanons  Th 400G




But what if the options in these drop lists just don’t provide the kind of filter you are looking for? In Project 2007, you can build your own filters and base them on just about any criteria you can think of. For example, take a look at the following project.
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What if we wanted to display only tasks that have a duration that is greater than or equal to 1 week and that have a percent complete less than 85%? We may be able to configure a combination of AutoFilters to do this, but it could be tricky, requiring the addition of new columns into the task entry table and the customization of the AutoFilter XE "Filters:AutoFilter"  criteria. A better way to accomplish our goal is as follows.

First, choose Project, followed by Filtered XE "Filters:Customizing"  For, and then followed by More Filters.
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In the More Filters dialogue, select the Task radio button, and then click the New button. (You could also select the Resource radio button to create a custom resource filter.)
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When you click New you will see a Filter Definition dialogue box.
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In this dialogue, you can click on a row under the field name column to choose from a list of possible fields. In this case we have chosen % Complete.
Next, click in the same row under the Test column to select the type of test you want to apply to the % complete field (or whatever field you choose). In this case we will test that the % complete is less than or equal to 85%. (Above, you can see that the value 85% was entered directly into the same row under the Value column.)
When you click the OK button, the filter we just created (which we named MyFilter) will be saved in the list of available filters. Now, all you have to do is find the new filter in the More Filters dialogue and click the Apply button.
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Here is the filtered list of tasks. Can you see any changes from the original list?
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Tasks 1 and 15 have been filtered out, as they did not meet the requirements of our custom filter (%complete <= 85%).
Here is another custom filter setup. Try to guess what this filter does.
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This filter will only display tasks that have a percent complete that is less than 85% and a duration that is greater than or equal to 1 week. (You can add a logical AND or a logical OR to your filter by clicking in the and/or column.)

Here are the results of this custom filter.
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If you want to edit an existing filter, just display the More Filters dialogue, select a filter, and click the Edit button.
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When you click the Edit button, the rules for the selected filter will appear in the Filter Definition box.
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You can use the buttons shown below to insert, delete, or copy rows from the filter. 
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(Note: A row is a series of adjacent entries running across the Field Name, Test, and Value columns.)
Lesson 3.4: Creating Progress Lines

Microsoft Project 2007 has an interesting graphical tool called progress lines XE "Progress Lines:What are?" . These lines can help you track your project’s progress. These lines are added to the Gantt chart XE "Gantt Chart"  to help you determine how your tasks are doing relative to the project schedule.
In this lesson you will learn how to display progress lines and interpret progress lines. You will also learn how to edit, remove, and format a progress line.
Displaying the Progress Line
Since progress lines are added to the Gantt chart XE "Gantt Chart" , first make sure that you’re in a Gantt chart XE "Gantt Chart"  view. Then, click the Tools menu, choose Tracking, and click Progress Lines.  XE "Progress Lines:Viewing" 
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Performing this action will open the following dialogue.
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There are three types of progress lines that are available from the dialogue. The following table offers a brief description of each.  XE "Progress Lines:Types" 
	Always Display Progress Line (circled in red)
	Choose to always display the current progress line at the current date or the project status date XE "Status Dates" .

	Recurring Progress Lines (circled in blue)
	Choose a date to have a progress line appear repeatedly, at every day, week, or month.

	Selected Progress Lines (circled in green)
	Set specific dates to have progress lines appear.


At the bottom right hand corner of the dialogue, you can choose a radio button to specify whether you want the progress lines displayed in relation to the actual plan or to the baseline plan.
The following image shows the dialogue settings for a basic progress line. An “always displayed” progress line for the current date has been selected. The progress line will be displayed in relation to the actual plan.
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Here is the resulting progress line.
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Interpreting a Progress Line
Here is a more detailed view of the sample progress line shown previously.  XE "Progress Lines:Interpreting" 
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When a progress line intersects a task with a left facing peak (third task from the top with a blue square surrounding the peak), the task in question is behind schedule.

When a progress line intersects a task with a right facing peak (bottom task with a green square around the peak), the task is ahead of schedule.

When a progress line intersects a task without any peak (the two tasks with red squares), the tasks are proceeding right on schedule.

Tasks that are scheduled for future dates are not affected (will not be touched or intersected) by the progress line.
Editing or Removing Progress Lines
To edit or remove the progress line, simply double-click it. This will open the Progress Lines dialogue. (You can also use the Tools -Tracking - Progress Line command again).

Now, you can remove a progress line simply by un-checking the corresponding box in the dialogue and then clicking the OK button, or you can add a progress line by setting additional options in the dialogue.  XE "Progress Lines:Removing 
Formatting a Progress Line
Like most other Project elements, you can easily change how the progress line looks. To do this, first open the Progress Line dialogue by double clicking the line in question and then click the Line Styles tab.  XE "Progress Lines:Formatting" 
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From this dialogue, you can choose the line type and colour, as well as the progress point shape and colour. You can also choose to show dates on each progress line; if this option is enabled, you will be able to choose the format and the font for the date.
Here is the same progress line as before, but with some additional formatting. The line itself is now yellow, and the progress points have been specified as red stars.
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You may also notice that the progress point for the bottom task is to the right of the finish date of the task itself. This is because the progress line in this example is displayed in relation to the baseline plan rather than the actual plan.  
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Remember, after you modify the progress line, click the OK button to implement the changes.
Lesson 3.5: Tracking Progress

So far in this section, we’ve seen how to update your project and how to keep an eye on how your project is progressing. In this lesson, we’re going to learn how to use the Project Guide XE "Project Guide"  to track your project’s progress.
Using the Project Guide XE "Project Guide" 
Perhaps the most straight forward way of tracking your project’s progress is to use the Track option on the Project Guide XE "Project Guide:Tracking pane"  toolbar.
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Once you display the Track task pane, you can click the “Check the Progress of the Project” link.
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Clicking this link will result in the following Project screen.
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There are a lot of unfamiliar elements on the screen shown here, so let’s address them one at a time. First, though, remember to specify the status date XE "Status Dates"  that you will use as a reference for your progress.
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About Status Indicators
From the sample image shown above, you can see that our task form has changed. For one thing, a Status Indicator XE "Status Indicator"  column has been added. Here’s what each of the icons in that column means.
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	Task is complete.
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	Task is not complete, but all scheduled work has been completed by the status date XE "Status Dates" .
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	All scheduled work has not been completed by the status date XE "Status Dates" .

	
	If the field is blank, it means the task isn’t scheduled to start until after the status date XE "Status Dates" .


Tracking Overdue Tasks with Filters
The Project Guide XE "Project Guide:Filtering with"  track pane offers a handy Filter drop list. You can use these filters as a quick and easy way of keeping track of various tasks.
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For example, we can see in the following small sample project that the task indicators tell us there are two overdue (running late) tasks.
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This is a perfectly fine way to track overdue tasks in a small project, but what about a project with hundreds of tasks?

For large projects you can apply the Late Tasks filter from the Track pane by clicking the appropriate option in the drop list.
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Performing this action will display a list of only the Late Tasks. The task table and Gantt chart XE "Gantt Chart"  for these overdue tasks will be available for you to examine.
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To return to the full task list, simply select All Tasks from the Filter drop list in the Track pane.
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Tracking Completed Tasks
Just as with overdue tasks, you can track completed tasks by looking at the task indicators.
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In the task list shown above, we can find three completed tasks (red squares) by examining the Status Indicator XE "Status Indicator"  field. Once again, however, the question arises: What if there are hundreds of tasks to keep track of?

The answer to this question is to use the filter options in the track pane just like before.
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By clicking the Completed Tasks option in the filter drop list, you will filter your tasks to display only the tasks that have been completed so far. Once again, both a task list and a Gantt chart XE "Gantt Chart"  will be provided for these filtered tasks.

[image: image295.png]Task Name. Stetus Indicator  Work | Durati | September 2006 | October 2006

Pz TR0]2 5 |8 [11 1417 PO [23[26 28] 2 |5 [ [T 1417 P02
1 [(Smeris v ows 1
z -

Excavete Lats
12| Landscaping

&= Surveyorl50%] 3
v rmws 5 D —tiid
NECE TR

B e —————]




You can, of course, perform any operation on these filtered tasks that you might perform on a task in the standard (all tasks) view.

To return to the full task list, just select the All Tasks option.
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Tracking Tasks by Grouping

You can also use the Apply a Group feature in the Project Guide XE "Project Guide:Grouping with"  track pane to help track tasks.
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In this image, a small project is displayed along with the Project Guide XE "Project Guide"  track pane. A Task Status grouping will be applied to the tasks by selecting the appropriate option from the “Apply a group” drop list.
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When you group your tasks in this way, all of the task information will be shown. More importantly, the tasks will be grouped according to the criteria you choose. In this case, the tasks will be grouped (and sorted) by their status indicator.
Here you can see that the completed tasks are grouped and listed first, followed by the on schedule tasks, followed by the late tasks, followed by the future tasks.
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Though this may seem trivial in a small project with relatively few tasks, it can be a big help with a very large project.

To return to your original screen, select the No Group option from the drop list.
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Section 3: Review Questions

1. Which of the following shapes is not available on the drawing toolbar XE "Toolbars:Drawing" ?
A. Polygon
B. Oval
C. Rectangle
D. Cube
2. To add a drawing to a chart, you should…
A. Click a shape on the Drawing toolbar and then single click the chart
B. Click a shape on the Drawing toolbar and then double click the chart
C. Click a shape on the drawing toolbar XE "Toolbars:Drawing"  and use your mouse to drag out the dimensions of the shape
D. Any of the above.
3. Which of the following shape properties can be modified?
A. Fill color
B. Line color
C. Number of dimensions
D. A and B
4. The option to update a single task is made available by…
A. Using the Tools - Tracking submenu
B. Using the Project - Information submenu
C. Using the View - Tables submenu
D. Using the Assign Resources dialogue
5. When you are updating an entire project it is important to consider the…
A. Number of tasks that you are updating
B. The type of tasks that you are updating
C. The date that you specify your tasks as complete through
D. None of the above.
6. To display a progress line, you should choose…
A. Tools - Tracking - Update Tasks
B. Tools - Tracking  - Update Project
C. View - Progress Lines
D. Tools -Tracking - Progress Lines

7. What is a status indicator?
A. A symbol that appears on the Gantt chart XE "Gantt Chart"  for a linked task.
B. A text message that appears when a task is complete.
C. A symbol that appears in a column of your task list, that indicates if your task is late, or on schedule.
D. None of the above
8. You can use the Project Guide XE "Project Guide"  to ….
A. Track Progress
B. Filter Tasks
C. Set a Status date
D. Any of the above.

9. When you are tracking a project with the Project Guide XE "Project Guide" , you can filter for…
A. Completed tasks
B. Tasks on schedule
C. Late Tasks
D. All of the above
10. When you are tracking progress with the Project Guide XE "Project Guide" , you can…
A. Group tasks by their status
B. Group tasks based on intervals
C. You cannot group tasks
D. Any of the above.
	Check your answers online at www.microsofttraining.net/?
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	Any other questions? Online support forum and knowledge base

www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft certified trainers


Section 4: Working With Multiple Projects

In this section you will learn how to:

· Compare and contrast Project Professional XE "Microsoft Project 2007:Professional edition" , Project Standard XE "Microsoft Project 2007:Standard edition" , and Project Server XE "Microsoft Project 2007:Project Server" 
· Open a resource pool
· Link a project to a resource pool
· Unlink a project from a resource pool
· Update a resource pool
· Insert subprojects
· Unlink or remove subprojects
· Consolidate projects
· Use the New Window command to consolidate projects
· Use workspaces
· View the critical path of a master project
· Save a baseline for a master project
· Save a baseline for a consolidated project
· View information for an inserted project
Lesson 4.1: Versions of Microsoft Project

A typical desktop installation of Project 2007 will come in one of two basic varieties: Standard, or Professional. 
So far this manual has dealt with features that are available in both the Professional and Standard edition, but now we’re going to devote some time to explaining the differences between the two versions. This discussion will also naturally include Microsoft Project Server XE "Microsoft Project 2007:Project Server"  2007 and the advantages that it can provide when working with projects in a distributed setting.
Project 2007 Standard
Project 2007 Standard Edition is a great choice for standalone project management. If you want to manage a project on your computer, and you are not required to exchange information with a server (e.g. manage project data collected from a number of sources remotely over a network) then Project Standard XE "Microsoft Project 2007:Standard edition"  is a reasonable choice.

As a standalone application, Project Standard XE "Microsoft Project 2007:Standard edition"  retains most of the basic functionality of the Project Professional XE "Microsoft Project 2007:Professional edition"  edition. The big difference between the two is that Project Professional XE "Microsoft Project 2007:Professional edition"  has the ability to work with Project Server XE "Microsoft Project 2007:Project Server"  in a distributed enterprise setting, whereas Project Standard XE "Microsoft Project 2007:Standard edition"  does not.

The following is a list of some of the new features in Project 2007 Standard edition.  XE "Microsoft Project 2007:New features"   

· Visual reports
· Multilevel undo
· Change highlighting
· Task drivers
· Costs and budget
· Calendar exceptions
· Revised custom field structure
In addition, the 2007 version of Project has a few new graphical elements that allow you to improve the appearance of your project and project reports. These include three dimensional Gantt bars and the ability to apply background color shading to individual cells in your project.

Although Project 2007 Standard is not intended for use with Project Server XE "Microsoft Project 2007:Project Server" , you can use it with shared documents stored in a Microsoft SharePoint services workspace XE "Workspaces" .
Project 2007 Professional

Project Professional XE "Microsoft Project 2007:Professional edition"  has all of the features of Project Standard XE "Microsoft Project 2007:Standard edition" . This means that it is also a viable choice for standalone project management, though there is little advantage over Project Standard XE "Microsoft Project 2007:Standard edition"  in this context. The key advantage to using Project Professional XE "Microsoft Project 2007:Professional edition"  comes from the ability to connect to Project Server XE "Microsoft Project 2007:Project Server"  2007 in an enterprise project management setting.

In addition to the features listed previously for Project Standard, Project Professional XE "Microsoft Project 2007:Professional edition"  provides the following functionality when used in combination with Project Server XE "Microsoft Project 2007:Project Server" : XE "Microsoft Project 2007:New features" 
· Map or convert custom fields, calendars, and resources to enterprise objects

· Save local copies of Project Server XE "Microsoft Project 2007:Project Server"  projects

· Import SharePoint Services projects
· Enterprise formula validation
· Provides a cache on the client side when used with Project Server XE "Microsoft Project 2007:Project Server" . This reduces the amount of data traffic on the network, thereby improving overall Project client/server interaction.
· Offline editing. When making changes to a project located on the Project Server XE "Microsoft Project 2007:Project Server" , you can work offline. The project information is stored in Project Professional XE "Microsoft Project 2007:Professional edition" ’s client side cash. When you connect again, Project will send a message to the Project Server XE "Microsoft Project 2007:Project Server"  queuing service to only save the changes to the project (see the bullet above).
· Use of deliverables, which is a list of milestones like items. This list can be linked to other projects. Projects can create dependencies based on these deliverables.
To summarize, Project 2007 Professional can be used for standalone project management (like Project standard) and for enterprise project management (large scale projects involving numerous company wide resources and contributors and the Project Server XE "Microsoft Project 2007:Project Server"  2007 platform). 

The most important thing to remember is if you want to use Project in combination with Project Server XE "Microsoft Project 2007:Project Server" , use Project Professional XE "Microsoft Project 2007:Professional edition"  edition.
Project Server XE "Microsoft Project 2007:Project Server"  2007
The purpose of Project Server XE "Microsoft Project 2007:Project Server"  2007 is to provide a means of centrally managing and standardizing projects of all shapes and sizes. Interaction with and management of the projects stored on the server is typically achieved by connecting to the server with Project Professional XE "Microsoft Project 2007:Professional edition" .

People involved in the project can enter project information from remote locations with their web browser through the server’s Web Access component. You can also interact with projects in a more direct way by using Project Professional XE "Microsoft Project 2007:Professional edition"  2007 as a client program connecting to the Project Server XE "Microsoft Project 2007:Project Server"  2007.
The design of Project Server XE "Microsoft Project 2007:Project Server"  2007 has been changed dramatically from previous versions.  These changes are intended to improve overall security, provide more programming and development functionality, increase reliability, and more closely integrate Project Server XE "Microsoft Project 2007:Project Server"  2007 with Windows SharePoint services.

For a full enterprise solution, Project Server XE "Microsoft Project 2007:Project Server"  2007 works in combination with Windows Server 2003 (enterprise or standard), a database server (like Microsoft SQL server), SharePoint services, and the .NET framework. 

Project 2007 Standard edition cannot be used with Project Server XE "Microsoft Project 2007:Project Server"  2007. If you want to work with Project 2007 server, you should use Project Professional XE "Microsoft Project 2007:Professional edition"  as your client program. (A client program is the application that you use to communicate with the server.)
As a result of the extensive differences between Project Server XE "Microsoft Project 2007:Project Server"  2007 and previous versions, the Project 2007 Professional client cannot connect to a Project 2003 server. Similarly, the earlier Project 2003 Professional client cannot connect to a Project 2007 server.
The following table contains a brief list of some of Project Server XE "Microsoft Project 2007:Project Server"  2007’s new features.  XE "Microsoft Project 2007:New features" 
	Improved Platform Programmability
The new application programming interface (referred to as the Project Server XE "Microsoft Project 2007:Project Server"  Interface, or PSI) provides developers with a better set of tools for programming and modifying client server functionality.


	Improved Web Access Security
Client programs like Project Professional XE "Microsoft Project 2007:Professional edition"  2007 communicate with Project Server XE "Microsoft Project 2007:Project Server"  using common widely used protocols such as HTTP and SOAP (which is based on HTTP and XML). Because of this, it is easier to configure a network firewall for safe Internet access.

	Improved Extensibility
The design of Project Server XE "Microsoft Project 2007:Project Server"  2007 is now more open for integration with other Microsoft Office system programs.

	Server Side Scheduling
Previously, the Project scheduling engine was only available in the client program (Project Professional XE "Microsoft Project 2007:Professional edition" ). Now, Project 2007 has its own scheduling engine that permits project updates without relying on Project Professional XE "Microsoft Project 2007:Professional edition" .


	 Project Server XE "Microsoft Project 2007:Project Server"  Queuing Service
The new Project Server XE "Microsoft Project 2007:Project Server"  queuing service is designed to handle severe loads on the server more consistently and with greater reliability.


Comparing Project Professional XE "Microsoft Project 2007:Professional edition" , Standard, and Server
The following table provides some comparison points between the three major Project software packages.  XE "Microsoft Project 2007:Comparing editions" 
	Project Professional XE "Microsoft Project 2007:Professional edition"  2007
	Project Standard XE "Microsoft Project 2007:Standard edition"  2007
	Project Server XE "Microsoft Project 2007:Project Server"  2007

	Supports connection to Microsoft Project Server XE "Microsoft Project 2007:Project Server"  2007
	Does not support connection to Project Server XE "Microsoft Project 2007:Project Server"  
	Can be accessed by  Project Professional XE "Microsoft Project 2007:Professional edition"  2007 or with Internet Explorer (version 6.0 or later) via Project web access

	Intended for stand alone or enterprise project management (central management of project information from multiple remote sources) 
	Intended for standalone project management (desktop project management)
	Intended for enterprise project management 

	Cannot be used with Project Server XE "Microsoft Project 2007:Project Server"  2003
	Cannot be used with any Project Server XE "Microsoft Project 2007:Project Server" 
	Cannot be used with Project Professional XE "Microsoft Project 2007:Professional edition"  2003 

	Can be installed side by side with Project 2003 Professional

	Not recommended to install side by side with Project 2003 Standard or Professional
	Can be installed side by side (on the same hardware) as Project Server XE "Microsoft Project 2007:Project Server"  2003

	More collaboration tools
	Very limited in terms of collaboration
	The central repository for project collaboration  

	Considered to be the standard client program for Project Server XE "Microsoft Project 2007:Project Server"  2007 and an essential component in the Microsoft enterprise project management system.
	Not a  client for Project Server XE "Microsoft Project 2007:Project Server" 
	Also an essential component in the Microsoft enterprise project management system.


You shouldn’t think of one version of Project being any better than another. The version that is best for you depends on what tools you need and what kind of environment you work in. If you’re a small business owner who uses Project for simple task management you’ll probably find that the Standard edition works great for you. If you’re a project manager for a global corporation with thousands of employees, you will appreciate the tools Project Professional XE "Microsoft Project 2007:Professional edition"  offers.

Lesson 4.2:  Working with Resource Pools

A resource pool XE "Resource Pool:What is?"  is a project file that serves as a master list of resources. You can link multiple projects to this resource pool to:
· Ensure consistency across projects

· Save you from entering the same information over and over again

· Prevent resource conflicts across different projects

· Allow you to see scheduling for all of your resources in one place

As an example, suppose that a computer programmer (a resource) is scheduled to work on a development project (a video game) for the entire month of April. Now, let’s say that for a few days in April, the same programmer is scheduled to be on a planning and design team dedicated to an entirely different development project (an MP3 player).
Because the resource is contributing to separate projects, it is quite possible that this resource conflict could be missed until the actual day where the programmer was required for both tasks arrived. At this point it might be too late to reschedule or find another resource.
If you’ve used a resource pool, however, you will easily be able to identify conflicts and over-allocations, even across different projects.  XE "Resource Pool:Advantages of" 
Another good thing about resource pooling is that Project Standard XE "Microsoft Project 2007:Standard edition"  users can take advantage of it. Although Microsoft Project Standard XE "Microsoft Project 2007:Standard edition"  2007 doesn’t have all the collaboration features of the Professional edition, you can still share resources among different projects through a resource pool.

Starting a Resource Pool
To start a resource pool, first open a blank project, and then switch to Resource Sheet view. Next, enter (or import) your resources in the usual way. Remember to keep the resources limited to those that will be used across several projects.  XE "Resource Pool:Starting" 
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Once you enter your resource list, save your file as you normally would, with an .mpp extension. That’s it!
Linking a Project to the Pool
To link a project to a resource pool, you must have both files open at once. Then, in the main project, click the Tools menu, choose Resource Sharing, and click Share Resources.  XE "Resource Pool:Linking a project to" 
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When you perform the action described above, you will see the following dialogue.
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This dialogue provides options for what resources to use, and for what to do when a conflict in calendar or resource information occurs. To use the resources from the resource pool, select the “Use resources” radio button. 

If you select the “Pool takes precedence” radio button, the resource information from the resource pool will take precedence over the resource information in the Project that is sharing with the pool. This information can include resource availability, max units, pay rates, calendars and more. For example, if a resource named Bob Smith has a rate of $25 /hour in the resource pool, and the same resource has a rate of $30 /hour in the sharing project, the rate from the pool will apply.

If you choose “Sharer takes precedence,” the information from the sharing project will win out over the information in the resource pool. In the case described above, Bob Smith’s rate will be $30/hour (the rate from the sharing project).  XE "Resource Pool:Precedence options" 
Once you click the OK button, the sharing will begin. Note that the sharing of resources goes both ways. Resources in the main project file are added to the pool, and resources in the pool are added to the main file.

Creating a Resource Pool from Multiple Projects

You can also create a resource pool from the resources that already exist in different projects. To do this, you must first open up all of the projects that contain the resources that you want to use.  XE "Resource Pool:Creating from multiple projects" 
Next, check the Resource Sheet views in your open projects.
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If the same resource is used in multiple projects, make sure that the names for the resource are the same in all projects that it is used in.

Next, click the New button ([image: image306.png]


) and then display the Save As dialogue for your new project.
In the Save As dialogue, enter a file name that is indicative of the file’s purpose (like Resource Pool), and choose an appropriate folder to save your file in. Save your file as an .mpp file.
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Now, under the Window menu, select a project that contains resources that you want to copy into your new resource pool.
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Next, choose Tools, followed by Resource Sharing, followed by Share Resources.
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In the Share Resources dialogue XE "Resource Pool:Share Resources dialogue" , choose the Use Resource radio button, and select your new resource pool in the From field.
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Choose which project should take precedence (the pool or the sharing project) with the bottom two radio buttons. Once you are ready, click the OK button at the bottom of the dialogue.
Now, select the next project that you want to copy resources from in the Window menu.
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Again, choose the Tools menu, followed by Resource Sharing, followed by Share Resources. In the Dialogue, make the same settings as before.
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Once you are ready, click OK.
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Here is the resource sheet view of the new resource pool file. It contains all of the resources from the two projects we used in this example. The procedure described above also links the projects involved to the resource pool. The resources shown in red have been over allocated (probably between the two projects).
Unlinking a Project from a Resource Pool
If you decide you don’t want a project linked to a resource pool, click the Tools menu, choose Resource Sharing, and click Share Resources. Then, in the Share Resources dialogue XE "Resource Pool:Share Resources dialogue" , choose Use Own Resources.  XE "Resource Pool:Unlinking a project from" 
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The sharer file (your main project) will go back to its original state. The resource pool, however, will keep the resources it gained from the main file.

Updating a Resource Pool

It is easy to update XE "Resource Pool:Updating"  a resource pool. First, close all projects that are linked to it, and then open the resource pool in question. You will then see the following dialogue:
[image: image315.png]Open Resource Pool X

This il s the resource pool for many projects, What do you want to
do?
Vou can:

@ e Tesiirce pool fsad-orly siowing others t work o
‘Projests connected to the pool,

O Open resource paol read-rite o that you can make changes to
resaurce information (ke pay rates, etz.), akhough this wil ock.
others out of updating the pool wih new informetion.

© Open resource pool read-write and al other shrer fils into 3 new
master projectFle. Yau can access this new master project Fle
from the Window men command,





Choose the second option (read-write) so you will be able to add resources to the resource pool’s list and save the changes. The next time that a linked project is opened, the project’s resource sheet will be updated to correspond with the changes you made to the resource pool.
Lesson 4.3: Working with Multiple Projects, Part One

By now, you are probably quite skilled at the art of using Microsoft Project 2007 to create and manage a project plan. Did you know, though, that you can use Project to manage multiple projects in several ways? This is what we are going to discuss in this lesson.

Types of Multiple Projects
In the context of this lesson, there are two main ways of using multiple Projects that we will be concerned with. The first of these is the use of master and sub projects.
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Here, you can see that a Project called HousingProject2 has been inserted into the list of tasks for the original project. In this case, the inserted project is referred to as the subproject. The project that contains the subproject is referred to as the master project.  XE "Subprojects:What are?" 
If you examine a master project that contains a sub project, you will see that the start of the subproject is marked by three things: slightly larger type for the project name, a special task indicator ([image: image317.png]


) and renumbered tasks.
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The other method of working with multiple projects that we will learn about is consolidated projects. With consolidated projects, the tasks and resources for multiple projects are merged into one file. Changes to this file or to the projects that it was consolidated from will be distributed to all projects files involved. 
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You will notice that the consolidated projects have a larger font face, and a special task indicator (much like an inserted sub project).

Inserting Sub Projects
Inserting a subproject XE "Subprojects:Inserting"  is a lot like inserting a task. First, switch to Gantt chart XE "Gantt Chart"  view and select the task that is currently in the place where you want the sub project to appear. Next, click the Insert menu and click Project.
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In the Insert Project dialogue, choose which project you want to insert.
[image: image321.png]Insert Project

Lookin: (&) MyFolder
2y Recent | (Gcopy ofrousnaprcti.m
Documents | @] tousngbroect1. g
s"}v Hetwork | [ ResourcePool2.mpp.
Paces

@ vesicon

w
2 Conputer

o
Documerts
(= Projectzn07

(3 MyFolder

File pame:

Files o bype. [ icrosoft Project Fls (*.mpp; *.mpd)





When you click Insert, you will be warned of any scheduling conflicts and then the subproject will appear in your master project. You can then expand the subproject to see its individual tasks and other information in the usual way.
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Here you can see the inserted subproject (larger font and special [image: image323.png]


 task indicator).
Unlinking or Removing Sub Projects
If you want to, you can either unlink XE "Subprojects:Unlinking"  a subproject from its source file or remove a subproject from the master project entirely. If you unlink the subproject from its source file, any changes made to the master file won’t affect the sub project’s source file, and vice versa.
To do this, first open the task information for the main (summary) subproject task. 
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Next, click the Advanced tab, and then uncheck the “Link to Project” box. Once you click the OK button, the subproject will be unlinked from its source file.
To remove a sub project entirely, right click on it in the task list of the master project and select Delete Task from the pop up menu.  XE "Subprojects:Removing" 
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In the Planning Wizard dialogue that appears, select the top radio button (continue) and click OK to remove the subproject.
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Consolidating Projects
The first step in consolidating XE "Consolidated Projects:Creating"  multiple projects is to create a blank project. Once you have done this, place your cursor at the beginning of the task list, and click the Insert menu followed by the Project option XE "Project Files:Consolidating" .
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In the Insert Project dialogue, navigate to the appropriate folder and select the projects that you want to consolidate. (You can select multiple projects by hording the Ctrl key when you click the files.)
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Once you click the Insert button, the consolidation will be complete. You can now work with the newly consolidated project as you would any other.
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Consolidating Projects Using the New Window Command
Another way to consolidate projects is to use the Window menu.  XE "Consolidated Projects:Creating" First, you must make sure that you have all the projects you want to consolidate open.  XE "Project Files:Consolidating" 
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Next, click the Window menu and click New Window.
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When you see the New Window dialogue, hold down the Ctrl key and click the projects you want to consolidate. Once you are ready, click the OK button.
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 These actions produce the same result as consolidating the projects into a blank project.
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Using Project Workspaces

If you find that you open and use the same multiple projects reputedly, you can save a workspace XE "Workspaces"  to make things more convenient.

You can save these files as in workspace XE "Workspaces" , so that whenever you open the workspace XE "Workspaces" , multiple files are opened as a set. This can be a great timesaver if you frequently check up on the same set of projects.

To create your workspace XE "Workspaces" , first open all the projects that you want in the workspace XE "Workspaces" , and close any that you don’t want included. Then, click the File menu and click Save Workspace.
[image: image334.png]tew, i+
open. ctivo
dose

ave cti+s

Page Setup

Print Preyien




Now, you will be prompted to save the workspace XE "Workspaces"  with the Save Workspace dialogue. (Workspaces have an .mpw file extension.)
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Navigate to the folder of your choice, and specify a name for your workspace XE "Workspaces" . Click the Save button when you are ready.

Once the workspace XE "Workspaces"  is saved, you can open it with the File - Open command.
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Lesson 4.4: Working with Multiple Projects, Part Two

Now that we know how to combine multiple projects, we’re going to learn how to format the critical path, save baselines, and view subproject information.
Viewing a Master Project’s Critical Path
To see the critical path for a master project XE "Master Projects:And critical path"  in Project 2007, click the Tools menu and click Options.  Next, click the Calculation tab and make sure the “Inserted Projects are calculated like Summary Tasks” box is checked.  XE "Options Dialogue:Inserted project options" 
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Now, to view the critical path for the master project, use the Gantt chart XE "Gantt Chart"  wizard ([image: image338.png]


) to apply a critical path to the Gantt chart XE "Gantt Chart"  or select the Tracking Gantt XE "View Commands:Tracking Gantt"  view.
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As you can see, the critical path for the sub project is not visible. Only the critical path for the master project can be seen.

If you clear the “Inserted projects are calculated like summary tasks” check box (in the Options dialog), you will see the critical path for the sub project as well.
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Here is the resulting critical path. As you can see, the critical path for the sub project is now visible along with the critical path for the master project.
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Saving Baselines for a Master Project
To save a comprehensive baseline for all tasks in the master project (including the tasks in the inserted sub project), first make sure that the sub project’s tasks have been expanded.  XE "Master Projects:And baselines" 
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Next, use your mouse to select all tasks in the Project, and then choose Tools, followed by Tracking, followed by Set Baseline. 
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In the Set Baseline dialogue, choose the Selected Tasks radio button, and then click OK.

[image: image344.png]Set Baseline

@ et baseline:
Baselne

O set interim glan

For:
Entire project

©Eekctedtadks

Rolup baselines
7o al summary tasks
[CErom subtasks into selected summary taskis)





A baseline for all of the tasks in the master project should be set.
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If you want a baseline that does not include the sub project tasks, do not select any tasks before using the Set Baseline command. Next, in the Set Baseline dialogue, choose the entire project radio button.
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This results in a baseline that does not include the sub project tasks.

Saving Baselines for a Consolidated Project 
Even if you have consolidated your projects, you can still see a baseline. First, expand the summary tasks that correspond to the projects so all tasks are visible.  XE "Consolidated Projects:And baselines" 
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Next, select all of the tasks with your mouse, and then use the Set Baseline command as before (Tools - Tracking - Set Baseline).
In the Set Baseline dialogue, choose the Selected Tasks radio button and click the OK button.
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You will now have a baseline for all tasks in the consolidated projects.
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Viewing Information for Inserted Projects
To view subproject information, you can double-click the subproject indicator ([image: image350.png]


) or select the subproject and click Task Information. The dialogue you will see is very much like the Task Information dialogue:  XE "Master Projects:Project Information for" 
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In this dialogue, we can change the name of the subproject by entering a new name in the Name field (advanced tab).
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 We can also change the linked file that is the source for the subproject. (Of course, if we change the source file for the subproject, the subproject tasks will change accordingly.) To change the source file, use the Browse button to find a new project file for the source.
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We can also make the sub-project’s source file read only so no changes can be made to it from this project. If we wish, we can unlink the subproject totally by clearing the checkmark in the Link to Project box.
In addition, the other tabs provide options for adding dependencies (Predecessor tab), Resources, Custom Fields, and annotations (Notes tab), just as with other project tasks.
Section 4: Review Questions

1. Which version of Project is the recommended client for Project Server XE "Microsoft Project 2007:Project Server"  2003?
A. Project Professional XE "Microsoft Project 2007:Professional edition"  2007
B. Project Standard XE "Microsoft Project 2007:Standard edition"  2003
C. Project Professional XE "Microsoft Project 2007:Professional edition"  2003
D. Project Standard XE "Microsoft Project 2007:Standard edition"  2007
2. Which of the following programs can be used as a client with Project Server XE "Microsoft Project 2007:Project Server"  2007?
A. Project Standard XE "Microsoft Project 2007:Standard edition"  2007
B. Project Professional XE "Microsoft Project 2007:Professional edition"  2003
C. Project Server XE "Microsoft Project 2007:Project Server"  2003
D. Project Professional XE "Microsoft Project 2007:Professional edition"  2007
3. Project Server XE "Microsoft Project 2007:Project Server"  is designed to facilitate…
A. Standalone Project management
B. Project management for a small company
C. Standardization and centralization of large projects that may involve remote sources of information
D. Import and export of Excel spreadsheets
4. Which of the following statements is true?
A. You cannot access Project Server XE "Microsoft Project 2007:Project Server"  2007 with a web browser
B. You can connect directly to Project Server XE "Microsoft Project 2007:Project Server"  with Project Standard XE "Microsoft Project 2007:Standard edition"  2007
C. You can access Project Server XE "Microsoft Project 2007:Project Server"  information with Internet Explorer 6.0 or higher and Project Web Access
D. You cannot connect directly to Project Server XE "Microsoft Project 2007:Project Server"  2007 with Project Professional XE "Microsoft Project 2007:Professional edition"  2007

5. A resource pool is a ….
A. Storage area for cost resources
B. Data structure that is used to sum fixed costs for a single task
C. Project file that contains resources that are shared among projects
D. A list of resources that does not contain conflicts
6. A subproject is ….
A. A sub task
B. A small project
C. A project developed using Project Standard XE "Microsoft Project 2007:Standard edition"  edition
D. A project that has been inserted into another project
7. Which of the following statements is true?
A. You cannot view the critical path for a sub project
B. You cannot view the critical path of a master project
C. You can view the entire critical path for a consolidated or inserted project
D. None of the above
8. For better tracking results with a consolidated project, you should….
A. Save a baseline for the entire project

B. Never use the Project Guide XE "Project Guide"  for tracking
C. Not filter for overdue tasks
D. Remove any links to a resource pool
9. To save a baseline for a consolidated project, you can…
A. Select all of the tasks and click the Save Baseline button
B. Select a single task and choose Tools- Tracking - Update Project
C. Choose Tools -Tracking - Update Task 
D. Select all of the tasks, and then choose Tools - Tracking - Set Baseline
10. What extensions do Project workspaces use?

A. .mpw
B. .mpx
C. .wps
D. .mpp
Section 5: Using Macros

In this section you will learn how to:

· Record a macro
· Play a macro
· Change macro security
· Use the default macros
· Delete macros
· Copy macros from other files
· Assign a shortcut key to a macro
· Use the Step Into feature
· Use the Visual Basic Editor XE "Visual Basic Editor" 
· Add code to your macro
· Add comment statements to your macro
· Declare variables
· Create a message box
· Use If Then statements
· Iterate through tasks 
Lesson 5.1: Recording Macros

A macro can be thought of as a stored sequence of actions or commands that can be performed repeatedly by the user. When you create a macro, Project 2007 will record the sequence of actions or commands that you perform as a series of program statements. These statements are constructed with something called VBA XE "VBA" \t "See Visual Basic for Applications"  (Visual Basic for Applications XE "Visual Basic for Applications" ) code. When you replay a macro, the VBA XE "Visual Basic for Applications"  statements that it contains are executed by your computer, and the actions or commands that the code defines are performed.

The result of all this is that you can record procedures that require multiple actions (like multiple menu selections, changing views, or clicking multiple toolbar commands), and then replay the procedures so the sequence of actions is performed automatically.

Recording a Macro

To record a macro in Project 2007, you can display the Tools menu, and then choose the Macro option, followed by Record New Macro XE "Macro:Recording" .

[image: image354.png]Tooks

4

Project  Report  Collaborate

Speling.

AutaCorrect Options.
Document Management
Lirks Between Projects,
Import Outlook Tasks.
Changs Working Time.
Assign Resaurces,

Buld Team from Enterprie,
Substiute Resources
Local Project Cache
Resource Sharing

Level Resources.

2

A+F10
ctieT

Trackng

tacro b tacros. akiFs
Organizr. 3 Record NewMacro... |
Customies seurty. ’
aptions. 79 veualBasic Edtor  At+F11

Enterprise Options





This action will display the following dialogue:
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In the Macro Name field, you can enter a name for your macro. You can also assign a shortcut key to the macro in the field provided.  XE "Macro:Assigning shortcut keys" You can also choose to store your macro in the Global File (where it will be accessible to all projects) or in the current project (where it is accessible to that project alone).

Near the bottom of the dialogue, you will see two pairs of radio buttons. One pair of radio buttons has the heading “Row References” and the other pair of radio buttons has the heading “Column References.” These headings refer to the columns and rows in the table or view you use when you record your macro. If you click the Relative radio button, the macro will perform actions relative to your starting position. If you click the Absolute button, the macro will perform actions on the same rows (or columns) every time, regardless of your start position.  XE "Macro:Relative vs. absolute positioning" 
If this seems confusing, take a look at the following simple example.
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In the image shown above, you can see that the top row is currently active. This is your start position.

Now, you can display the Record Macro dialogue XE "Macro:Record Macro dialogue"  (Tools – Macro – Record New Macro), choose a name for your macro, store it in the current project, and choose relative Row References.
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Once you are ready with your settings, click the OK button to record the macro. Then, immediately select the first two rows below your start position.
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This simple action is all that we’ll need for this sample macro. To stop recording, choose Tools, then Macro, then Stop Recorder.  XE "Macro:Stop recording" 
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Now that the macro has been recorded, we can replay it at our convenience. Because we chose relative row references, the actions that are performed by the macro will be relative to our starting row. 

For example, if we make the seventh row down active…
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And then run the macro…
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The relative rows will be recorded. If you remember, we selected the second and third row in the table when we first recorded our macro. Because the macro was recorded with relative row references, the actions of the macro will be performed relative to the stat position (active row). 

If we had chosen the Absolute radio button for our row references, the same rows would be selected every time the macro was played, regardless of where we start from (active row). This same reasoning can be applied to the column references as well.  XE "Macro:Playing" 
There is more than one way to record a macro in Project 2007. You can also display the Visual Basic toolbar XE "Toolbars:Visual Basic"  by choosing View, followed by Toolbars, followed by Visual Basic.
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When you perform this action, you will see the following toolbar appear.
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To record a macro, simple click the Record button on the toolbar ([image: image364.png]


). When you do this, you will see the same Record Macro dialogue XE "Macro:Record Macro dialogue"  as before.
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When you click OK, the macro will start recording. While the macro is recording, the record button on the toolbar will turn into a stop button.
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To stop the recording, just click the Stop button.

Here is a step by step procedure for recording a macro.  XE "Macro:Recording" 
· Plan out your macro. Know what you want to do and practice the commands so you will not make mistakes when you are recording.

· Use the Tools – Macro – Record New Macro option or the Record button on the Visual Basic toolbar XE "Toolbars:Visual Basic"  to display the Record Macro dialogue XE "Macro:Record Macro dialogue" .

· Set up your macro name, absolute or relative references, and other options in the dialogue. Click the OK button to start recording.

· Perform the sequence of actions or commands that you want to record as a macro.

· Stop the recording by using the menu options or the Stop button on the Visual Basic toolbar XE "Toolbars:Visual Basic" .
Playing Macros

To play a macro, choose the Tools menu followed by the Macro option, and then Macros. (Note that you can also use the Alt + F8 shortcut.)  XE "Macro:Playing" 
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In the Macros dialogue, choose a source to run your macro from by choosing an item from the “Macros In” field.
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Your choices will include any one of the currently open projects, the global file, the currently active project (this project), or all open Projects.

When you choose a source from this list, all available macros in the source will appear in the main area of the dialogue.
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In this image, the source for the macros is All Open Projects. The macros listed in the main area of the dialogue are all of the macros available in the Open Projects. To play one of these macros, click on it to select it, and then click the Run button.

You can also run a macro using the Run Macro button on the Visual Basic toolbar XE "Toolbars:Visual Basic" .
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Clicking this button will display the Macros dialogue shown above. From this point, just follow the same procedure to select and run the macro.

Also remember that when you first record a macro, you are given the option of setting up a shortcut key. Once the macro is recorded, you can use this shortcut key to run the macro directly.

Macro Security
Macros can be great for automating tedious procedures or for performing tasks that cannot be completed with a single command or mouse click. However, macros do have some security issues that must be considered. Remember, macros are just sequences of Visual Basic instructions that are encapsulated in a code module. In a sense, your computer does not really care about the purpose of the instructions that it is asked to execute; it just executes them. This means that it can run bad instructions (malicious code) just as easily as it can run proper (well intentioned) code. Because of this, macros can be a potential source of computer viruses, and therefore constitute a legitimate security concern. Fortunately, there are some security options provided in Project 2007 that can help you to manage this issue.  XE "Macro:Security" 
To see your macro security settings, click the Security button on the Visual Basic toolbar XE "Toolbars:Visual Basic" .
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Alternatively, you can choose Tools, followed by Macro, followed by the Security option. (You can also set up macro security by clicking the “Macro Security” button under the security tab in the Options dialogue.)
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These actions will display the following Security dialogue:
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As you can see, the dialogue has two tabs: Security Level and Trusted Publishers XE "Trusted Publishers" . Under the Security Level tab, you will see four options from which you can choose by selecting the corresponding radio button.

The first option (Very High) is the strongest level of security. With this level of security you will only be allowed to run macros that are stored in a trusted location. By default, the trusted location for Project 2007 is the Global template file (Global.mpt). If you use the Very High security setting, and you try to run a macro that is not stored in the Global file, the Run option will be deactivated.
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If you use the second security option (High), only macros that have been signed by a trusted publisher are allowed to run. (Macros in trusted locations will also be allowed to run.) 

A trusted publisher is an entity that signs their macros with a signature that you have deemed authentic and trustworthy. The technical details of digital signatures are beyond the scope of this discussion, but suffice it to say that in the case of a digitally signed macro, you can be reasonably assured that the integrity and authenticity of the macro is genuine, provided you trust the signer, and they are in your Trusted Publishers XE "Trusted Publishers"  list.

In the context of macros and digital signatures, authenticity means that the macro has indeed come from the publisher who claims to have created it. Integrity means that the macro has not been altered in any way since the publisher signed it. (To view your list of trusted publishers, click the Trusted Publishers XE "Trusted Publishers"  tab).

The next security option is the Medium level of security. If you use this option, you will be alerted when you open a project that contains a macro.
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When this dialogue appears, you can either enable or disable macros. If you disable macros, you will only be able to run the macros that are in your trusted locations (Global file). If you try to play a macro that is not in the Global file, the Run option will be disabled. If you choose the Enable Macros option, you will be permitted to run any available macro in the project, even if it is not digitally signed or stored in a trusted location.

Finally, you can also choose to use the Low level of security (though this setting is not recommended). Basically, with this setting you will be able to run any available macro, no questions asked!

To ensure the safety of your project plans and you company’s network, you should stick to either the Very High or High security settings.

Using Default Macros
When you display the Macros dialogue (by clicking the Run Macro button on the Visual Basic toolbar XE "Toolbars:Visual Basic"  or by choosing Tools – Macro – Macros), you will see a selection of default macros available in the global template file.  XE "Macro:Default" 
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These macros come installed with the Global file when you first install Project 2007. Since the Global file is a trusted location, these macros should be accessible to run under any security setting.

To run one of these default macros, select it by clicking it in the main list area, and then click the run button.

Now that you know how to play them, let’s have a look at these default macros on an individual basis. 

The Format_Duration macro will display a small box that allows you to select the duration unit for all tasks.
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If you use this macro, you will not change the duration of the tasks, but you will change the units that the duration is measured in.

The next default macro is called ResMgmt_TaskEntry. This macro will change the view to a combination screen that includes a task entry table, a Gantt chart, and a resource management form.

Here is a project in Resource Sheet view.
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The following image shows the same project after running the ResMgmt_TaskEntry macro.
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The last three macros are:

· Rollup_Formatting: Formats rolled up summary tasks

· Toggle_Read_Only: Toggles the file between read-only and read-write

· Update_File: Updates a read-only file to include the latest changes

Lesson 5.2: More Macro Tasks

In the previous discussion, you learned how to record and play macros, how to use the default macros from the global file, and how to work with the macro security settings.

Not surprisingly, there is still quite a bit more to learn on the subject of macros. In this lesson, you will learn how to delete macros, how to copy macros from other files, and how to use the Step Into feature. This will help prepare you for the final concept, where we will discuss the actual Visual Basic code in a macro.
Deleting Macros
It is a simple matter to delete a macro from your project. With your project open, choose Tools, and then Macro, followed by Macros.  XE "Macro:Deleting" 
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When the Macros dialogue opens, select the Project file that contains the macro you want to delete from the “Macros in” field. Next, select the macro that you want to delete in the large data area of the dialogue. Next, click the dialogue’s Delete button to remove it.
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After you click the Delete button, you will see a small (Yes/No) box appear to confirm your decision.
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If you click the Yes button, the macro will be removed. Now, just close the dialogue to return to your Project.
Copying Macros from Other Project Files
A situation might arise which requires you to copy a macro from one Project file (a project or a template) into another project file. One way to do this is to open both Project files: the file you want to copy a macro from and the file that will be the destination for the macro. In the destination file, choose the Tools menu, followed by Macro, followed by Visual Basic Editor XE "Visual Basic Editor" .
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When you perform this action, you will see the Visual Basic Editor XE "Visual Basic Editor"  window. This window is where you can edit, add, or even create your own Visual Basic code from scratch. (Remember the macros that you record are made from Visual Basic instructions.) 

In the next lesson we will look at the Visual Basic Editor in more detail; for now, we will be concerned with the Project Explorer pane on the left of the window.  XE "Macro:Copying" 
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If you display the Visual Basic Editor XE "Visual Basic Editor" , and you can’t see the Project Explorer, click the view menu from the Visual Basic editor’s menu bar and choose the Project Explorer option.
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If you look at the Project Explorer pane, you will see a list of modules for every open project and for the Global file.
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You can click the plus (+) sign in front of a given modules folder to see its contents. These modules serve as a kind of container for your Visual Basic code. When you record a macro, the code for the macro will be stored in a module in the same project that you create the macro for.

To copy a macro from one project file to another, just drag the module (which contains the macro) from the source file to the destination file. In the following image, Module1 was dragged from the Modules folder in the Projectmacro file up to the Modules folder in the EVAtest file. The module was automatically renamed to Module11 after it was dragged (copied) to its new location.
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Now the destination project file contains the same macro that was in Module 1 in the source project file.

For an alternative method of copying, you can double click on a given module in the Project explorer. The code contained in the module will then appear in the large editing area. You can then use your mouse to select the code, right click, and copy the code for the given macro to the clipboard.
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Next, double click on the destination module to open it, and then paste the copied macro into place in the large editing area.
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You can also copy macros from file to file using the Project Organizer XE "Project Organizer" , which we will discuss in Lesson 3.2.

Assigning Shortcut Keys

You may remember that when you first record a macro, you have the option of specifying a shortcut key for it. This option is available in the Record Macro dialogue XE "Macro:Record Macro dialogue"  box.  XE "Macro:Assigning shortcut keys" 
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This is certainly a convenient feature; but what if you recorded the macro without assigning a shortcut key? Or, perhaps you would like to change the shortcut key. 

To assign a shortcut key to an existing macro, open the Macros dialogue by choosing Tools –Macro – Macros or by clicking the Run Macro button on the Visual Basic toolbar XE "Toolbars:Visual Basic" .
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When the Macros dialogue appears, select the macro that you want to assign a shortcut key to, and then click the Options button.
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By clicking the Options button, you will see the following Macro Options dialogue box.
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In this dialogue, you can change the shortcut key that has already been assigned, or create a shortcut key if you did not assign one already, by entering the new shortcut key into the field provided. (Project will let you know if the key you choose is already in use.) Once you have made your changes, click the OK button.

Using Step Into
This next topic deals with a useful feature for analyzing and fixing macros. This feature is called Step Into, and while its benefits may not seem obvious at first, if you spend time building or editing the Visual Basic code in macros, you will appreciate its usefulness. The Step Into feature can be used to begin the execution of a macro at a specific statement in the Visual Basic code. The place in the code where you choose to start the macro is up to you.  XE "Macro:And Step Into command" 
For an example, let’s look at the following macro. Here we have an ordinary task entry list.
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A macro has been created for this project that will change the background colors of the rows in the list. To run the macro, we will click the Run Macro button.
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In the resulting dialogue, we will choose the macro that we want to run and click the Run button.
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Here is the result of running the macro.
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Now, suppose we want to run the macro, starting at a line of code that is not the first line. To do this, we can display the Macros dialogue, select the macro we want to work with, and click the Step Into button.
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When you perform this action, the Visual Basic editor will open to show the code for the selected macro.
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You will see a yellow arrow pointing to a Visual Basic code statement that is highlighted in yellow. You can drag this yellow arrow to any statement in the macro’s code.  XE "Visual Basic for Applications:Step Into" 
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In the image above, you can see that the arrow has been dragged down to the eighth statement. When we run the macro from within the Visual Basic Editor XE "Visual Basic Editor" , the macro will start running from this point (the yellow highlighted line of code).

To run the macro from this point, we can click the Run button ([image: image401.png]


) on the Visual Basic Editor XE "Visual Basic Editor" ’s toolbar.
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Here is the Project’s task entry list in its initial state.
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Here is the task entry list after stepping into the macro at the point specified above.
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You will notice that only the last group of rows (starting at row 8) has been colored. This is because we stepped into the code at the line that selects this group of cells. 
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The following image shows the entire code for the macro. The part of the code that was not executed is surrounded by a red border.
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You can use the Step Into feature to get an idea of what the different parts of the Visual Basic code do. If your macro does not work correctly, you can also use Step Into to try to find what part of the code contains the error.

As you work through the next lesson, you will probably come to appreciate the ability to find errors in your macro’s Visual Basic code.

Lesson 5.3: Visual Basic and Macros

As you already know, macros are built from Visual Basic statements. These Visual Basic statements are instructions that the computer follows to perform your macro’s specific task or tasks. As you have already seen, macros are stored in a kind of container called a module, and can be copied from file to file.

If you intend on doing any serious work with macros, it is probably a good idea to have some basic familiarity with the code used in macros. This can help you edit macros, repair macros that don’t work correctly, or even increase the power and flexibility of your macros.

In this lesson we will learn more about using the Visual Basic editor, and about different ways to add code to your macros. We will also look at some small samples of Visual Basic statements see a more finely grained view of how macros work. Finally, we will learn how to use comments to explain (document) our macros.

Opening the Visual Basic Editor XE "Visual Basic Editor" 
As you have seen in the previous lessons, the actual Visual Basic code for your macros can be viewed, edited, and managed in the Visual Basic Editor XE "Visual Basic Editor" . To display the editor, choose Tools, followed by Macro, and then Visual Basic Editor.
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You will then see the Visual Basic Editor XE "Visual Basic Editor"  screen.
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Across the top of the editor window, you will see a menu bar containing numerous menus for saving files, editing code, debugging code, running macros, inserting objects, and more.
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Just beneath this menu bar, you will find a toolbar containing quick access buttons for many of the menu items, including save, undo, help, copy, paste, and find.
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At the far right of this tool bar, you will see a field containing the line and column number of the cursor in the actual Visual Basic editing window. In this image, the cursor is at line 11 and column 24.

In the large main area of the Visual Basic editor, you will find the actual editing windows. 
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These editing windows are where you read, enter, and directly modify the Visual Basic code for your macros. You can even open a number of these windows at the same time for different code modules. This gives you great flexibility when it comes to modifying code, as you can review, enter, and copy and paste code from one window to another. 

Of course, each individual window has its own resize/minimize controls.
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In addition, each individual window can be repositioned and resized by dragging with your mouse. There is also a Window menu available on the editor’s menu bar for arranging your view.
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On the left of the Visual Basic editor window, you will see the Project Explorer panel. 
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This panel shows the code modules contained in the currently open projects and templates. 

If you double click on a code module in the project explorer, the code will open in an editing window where you can modify or add to it. You can expand and collapse the view of the contents with the (+) and (-) buttons. 

If you cannot see the project explorer panel in your Visual Basic editor, click the Project Explorer button ([image: image415.bmp]) on the toolbar to display it.
A fully detailed discussion of all of these menus and tools would require a manual of its own. In terms of this lesson, we will only need to use a few essential features of the Visual Basic editor to proceed with the concepts that follow.
Adding Code to Your Macro

The process of adding Visual Basic code to your macro does not always have to be difficult. There is an easy and useful shortcut you can take to add code in certain situations. Moreover, this particular shortcut can teach you a lot about how Visual Basic code works.

First, you have to know how to view the VBA XE "Visual Basic for Applications"  code for a macro. To see the code for a macro, first display the Macros dialogue.  XE "Macro:Coding manually" 
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You can see from the image above that there are two macros available for this workbook. If you select one from the list and click the Edit button, you will see the code for the macro that you selected in a Visual Basic window.

If there are no macros available for editing in your Macro Dialogue box, you can quickly record a simple macro by clicking the Record Macro button on the Visual Basic toolbar XE "Toolbars:Visual Basic" .
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After you specify a name and other settings for the macro, perform a sequence of actions or keystrokes for your macro and stop recording when you are finished. Once you have recorded a macro, invoke the macro dialogue box shown above, and select your new macro. Click the Edit button in the macro dialogue to view the macro code. 

A macro is essentially a small computer program written in Visual Basic. When you record a macro, Project writes the Visual Basic code for you. When you view the code for a macro, you are looking at the sequence of Visual Basic instructions that perform the specified tasks required of the macro. 

Once you can record a macro and view the code for it, you have at your disposal a clever way to learn about Visual Basic programming. You can easily record a macro, view the code for it, and try to figure out what the code statements do based on the function of the macro. If you experiment with recording different macros and viewing their code, you can really increase your understanding of Visual Basic instructions. Perhaps more importantly, you can use this method as a shortcut for adding code to your macro. 

The following code is for a recorded macro that shades a selected group of rows in the task entry list blue, and then changes the font color for the selected group to white.
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 The name of the macro is Macro4; it comes after the word Sub in the first line.
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Take a look at the following program statement:
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This instruction tells Project to select the rows starting at row 1, with absolute row references (same rows no matter what the start position), and a height of 3 additional rows. (The absolute row reference radio button was selected before the macro was recorded.)
Now look at the following two instructions:
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The first line tells Project to set the cell color for the selected rows to 5 (this number is interpreted as the color blue). The second line tells Project to set the font color of the text to 7 (7 is interpreted as white).

Finally, let’s look at this instruction.
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This line tells Project to select the cell in row 5 of the entry list, under the “Name” column. 

The words End Sub indicate the end of the macro.
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Here is the project’s task list before running the macro.
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Here is the same task list after running the macro.
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Now let’s say, that in addition, you want change the font style in the selected rows to be Bold. 

First, you should change the font color and cell shading back to the defaults (automatic) by selecting the rows, right clicking, and using the font options.

The next step is to record a new macro. Once you start recording, select the same group of rows, and click the Bold button on the Formatting toolbar to apply a bold font to the text. Remember to click the stop button on the Visual Basic toolbar XE "Toolbars:Visual Basic"  to stop the macro from recording.

If you now display the Macros dialogue box, you can select Macro5 (the macro that was just recorded) and click the Edit button to view the code. (Remember, you can choose whatever names you like for your macros when you record them.)
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Before you click Edit, you can see that there is also a macro named Macro4 available in the Project. Macro4 is the macro that modifies the selection with a blue background and white font.

Click the Edit button to view the code for the selected macro. When the Visual Basic window appears, you can see the code for macro 5.
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Rather than have to run both macros (one after the other) to achieve all of the modifications, you can copy lines of code from macro5 and then paste them into Macro4. The following two lines will be copied from macro5:
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To copy the code, select the lines of code you want with your mouse so they are highlighted in dark blue. Right click on the selection and choose Copy from the menu.

To open macro 4, we can double click on Module4 in the Project explorer.
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When the code window for macro4 opens, we will want to place the cursor after the last instruction in the macro, but before the words “End Sub.”
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To paste, make sure the cursor is at the correct position in the code. Then, right click and choose Paste from the menu.

If you do this correctly, Macro4 will now have two new lines of code, and be able to perform the functions of both macros.
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Notice that we only copied the functional code from Macro5. That is to say, we left the green colored comments, as well as the beginning and ending Sub statements (which define the start and stop points for the macro), behind. These lines of code were not copied because they would not add any additional functionality to Macro4.

Now, if you close the Visual Basic Editor XE "Visual Basic Editor"  and run Macro4 you will get all of the modifications at once.

Here is the task list before running the improved Macro4.
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The next image shows the same task list after running Macro4. Look for both the new colors and the bold font.
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You can use this method of recording separate macros and then adding code from one macro to another by copying and pasting to build macros with more complexity. Copying and pasting the code also helps to avoid typing errors that can occur when entering the code directly. 

Another way to combine the functionality of different macros is to use the Visual Basic Call statement. If you add a Call statement XE "Visual Basic for Applications:Call statement"  to a macro, the macro corresponding to the name that follows the word Call will run when the calling macro is executed. This allows you call (or play) a macro from within another macro.

The Visual Basic statement, Call Macro5 (when included in a macro), will run the macro named Macro5. The next image shows the original examples, Macro4 and Macro5; but now, Macro4 has a new statement before the “End Sub” line that says “Call Macro5.”
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When this Call statement is reached, Macro5 will be played.
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The image above shows the result of running Macro4 after adding the Call statement. Both Macro4 and Macro5 are executed; you can see that there is a change in font color, and the font is now bold.

Here are a few points to remember when adding code to a macro.

· A Visual Basic statement is interpreted as a complete instruction. A statement usually involves one or more keywords (words reserved in Visual Basic because they have a special function within the language). When you are editing the code for a macro in the Visual Basic Editor XE "Visual Basic Editor"  window, the key words will appear in a blue font.

· Try to use a single line for each Visual Basic statement (except for comments and if/then /else statements). Doing this will help the readability of the code that you add. If you feel that you have to, you can join individual statements on one line with a colon (:) but this can clutter your code and make it difficult to understand. 

· It is always a good idea to add comment statements to your code. Comments help you and anyone else who looks at the code understand what it does. (There will be more on adding comments in a moment.)
· All of the mathematical operators (*, +, -, /, ^) can be used in Visual Basic statements to perform operations on numbers. The order of operator precedence in Visual Basic is: exponentiation, multiplication, division, addition, and subtraction. You can also use parentheses to impose your own order of calculation. 

· Copying and pasting existing code helps to prevent errors. Visual Basic statements and keywords must be exact and adhere to certain rules for them to be executed correctly. It is easy to make mistakes in the structure or logic of statements when typing code, even for experienced programmers. Copying and pasting existing code that is known to work can help to avoid many errors.
· There is a wealth of information available on the web related to Visual Basic programming and macros. If you run into problems when adding code to a macro, keep this resource in mind.

Adding Comments to Visual Basic Code

A comment in a program’s code consists of a statement or statements that are added for informational purposes only. That is to say, a comment statement does not perform a task or action, or manipulate data or variables like regular program statements. Instead, comments are ignored when the program or macro runs, and are intended to clarify the meaning and purpose of programming statements when they are being viewed and edited.  XE "Macro:Commenting" 

 XE "Visual Basic for Applications:Comments" 
Most good programmers will agree that adding comments to code is an important and often neglected practice. Well documented code is much easier to understand, repair, and modify than poorly documented code. Furthermore, experienced programmers will sometimes use comments to help debug their code. For example, you can easily “comment” out a single line or several lines of code in a macro so they will be ignored when the macro is played. This will eliminate them as a possible source of error, and show you how the macro runs without them.

To add comments to a macro you must first display the Macros dialogue box by using the Run macro button on the Visual Basic toolbar XE "Toolbars:Visual Basic"  (or using the Tools – Macro – Macros menu options).

When the Macros dialogue appears, select the macro that you want from the list and click the Edit button to open it up in a Visual Basic editing window. 
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The statements in green (beginning with an apostrophe) are comments. When the macro is played, any lines beginning with an apostrophe (‘) will not be executed. In fact, they will be ignored completely. You can type pretty much anything you want after an apostrophe without creating an error in the macro. Clearly, comments are ideal for documenting Visual Basic code with information and hints as to what the code does.

The following line taken from the code shown above are comments giving the name of the program (Macro4), and identifying it as a macro.
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To provide more information to someone who is viewing or editing the code, you can type an apostrophe (‘) followed by whatever information you think is important to include.
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Now the comments include the name of the person that created the macro, as well as a brief description of the macro’s function.

We can easily append helpful information to a line of code by typing an apostrophe, and then a brief description of what the particular line of code does. Here is an example.
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To add this kind of comment to your macro, place your cursor at the end of the Visual Basic instruction that you want to elaborate on and type an apostrophe. Immediately following the apostrophe, add a description of what the particular line of Visual Basic code does and press Enter. Everything on the same line that comes after the apostrophe will turn green, meaning that it is a comment. Only the green text in the macro will be ignored when you run it. 

You can also place a comment on its own line, usually just above or sometimes just below the section of code it describes. To do this, just place your cursor on a new line above or below a statement or statements, and type an apostrophe followed by your comment. When you press Enter or an arrow key to move to the next line, what you typed will be recognized as a comment and turn green. If you think you need more than one line for a comment, take as many lines as you require, but be sure to begin each one with an apostrophe.

Here is an example of a commented macro.
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‘same rows) .
SelectRow Row

1, RowRelative:=False, Height
‘The following 2 lines change the background color (CellColor
'to blue(S=blue) and the text font color to white (7=white)
Font CellColor:=s
Font Calor

'The next line selects the cell in rov § under the "Neme" column
TSelectTaskField Rov:=5, Colwmn:="Nawe”, RouRelative:=False

Call MacroS 'This statement will run NacroS

End Sub 'This statement ends the macro




You should notice that the macro shown here contains a program statement that has been commented out. This means that an apostrophe has been placed in front of the statement so that it will not be executed.

Programmers often use this trick to eliminate a particular statement or series of statements as a possible source of error when they are trying to find mistakes in the program. 

 Lesson 5.4: Visual Basic for Project 2007

There is a vast array of potential Visual Basic instructions and functions that can be used in Project 2007 macros. To deal with them all in detail is far beyond the scope of this lesson. The purpose of the following discussion is to introduce you to a few useful statements and programming concepts, just to get you started with macro programming in Project. In the Step by Step exercise, we will actually try to create a macro from scratch using the concepts that follow.

Don’t get upset if you don’t understand the concepts presented here right away. Be patient, and review the concepts as much as you have to. Most of all, don’t be afraid to try out what you learn. Remember, the best way to learn about macro programming is by doing it!

Declaring Variables
If you want to build useful macros, you will probably want to manipulate your project data in some way. Probably the best way to do this is by using variables. Variables can be thought of as place holders for numbers or text. When you declare a variable, you are telling the Visual Basic interpreter to set aside a space in memory for a number or a text string. The amount of space required for a variable is specified by its type. Some of the important variable types in Visual Basic are:  XE "Visual Basic for Applications:Variables" 
· String (for strings of text data)
· Double (for large numbers with or without decimal places)
· Integer( for small to moderately sized numbers without decimal places)
· Long (for larger numbers without decimal places)
· Date (for holding date values)
· Variant (for any data type)
It is not absolutely necessary to formally declare variables in VB, but it is good programming practice. If you do not declare a variable explicitly, a VARIANT type will be assigned to the variable when you first use it. (Note that some programmers claim that VARIANT types can slow down your program or macro when there are a large number of calculations involved.)

Also, formally declaring a variable can help prevent programming errors. If a variable is not formally declared and it is misspelled somewhere in the macro code, it may be treated as a new variable. This can cause a malfunction in your macro that can be extremely difficult to find.

If you enter the words Options Explicit at the beginning of your macro, before the very first Sub statement, all variables will have to be formally declared for the macro to run. A misspelled variable will be easily detected because that particular spelling will not have been declared. 
To declare a variable, you must use the Dim keyword in the following way.


[image: image441]
As an example, the following statements declare an Integer, a Double, and a String respectively.


[image: image442]
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[image: image444]
Once a variable is declared, you can assign a value to it.

The statement smallNumber = 27 would assign the value of 27 to the variable smallNumber.

The names smallNumber, bigNumber, and someText are all valid variable names. You can combine numbers and text to form variable names, but a variable name should not start with a number or contain spaces that create two or more separate words. Also, you cannot use a Visual Basic keyword (a reserved word with a special meaning or purpose) as a variable name.

The following code declares an Integer variable named total and another integer named temp. The program assigns the value 5 to the variable total. The program then adds 2 to total, and finally, the value of total is assigned to the variable temp.

[image: image445.png]Sub Macrol()

'Decalare varisbles
Dim total is Integer
Din temp s Integer

‘hssign the value 5 to total
total = §

'hd the value 2 to total
total = total + 2 "Now tatal = 7

‘hseign the value of total to the varisble temp
temp = total

End Sub




Remember, you can think of a variable as a storage place for a value or a text string. You can perform mathematical and operations on numeric variables (like integers or doubles), and you can also arrange and manipulate text in String variables. The type of variable (integer, double, string) will help the Visual Basic environment manage the value that the variable contains. 

Sending a Message
Interaction with the user is an important part of any computer program, even an extremely small program like a macro. If you have data that you would like to display for the user, the simplest thing to do is use a message box.  XE "Visual Basic for Applications:Message boxes" 
Message boxes are very easy to create in Visual Basic. As a matter of fact, you can create a message box with just one line of code.

Take a look at the following macro:

[image: image446.png]Sub Hacroz ()

MsgBox "This is information”, vhOKOnly, "This is the titler

End sub




Now, take a look at what this macro creates.
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If you look at the macro’s statements, and then compare them to the resulting message box, you can see that the first quoted statement “This is Information” appears in the body of the message box. You can also see that the second quoted statement “This is the title” appears in the title bar of the message box. The term vbOKOnly XE "Visual Basic for Applications:vbOKOnly"  tells the Project to put an OK button in the message box. If you click the OK button, the message box will disappear. Finally, the term MsgBox tells project to create a message box containing the specified arguments (the stuff that follows the term MsgBox and that is separated by commas).

Now you have all the tools you need to create a simple message box that gives information to the user.
Using If Statements
If Then statements can be included in your macros to allow certain actions to be taken based on the results of tests that you specify. If Then statements are called conditional statements because they allow you to control the program flow, based on logical conditions that you establish.  XE "Visual Basic for Applications:If Then statements" 
The basic structure of an If Then statement is as follows.


[image: image448]
Here is an example.


[image: image449]
This statement tests the condition myValue = 100. If the variable myValue does equal 100, the variable tempValue will be assigned the value of myValue + 50. If myValue does not equal 100, the statement following the keyword Then will not be executed, and the program will continue with the statement on the next line.

If you have a situation where you need to perform multiple statements if the condition is true, you should structure the If Then as follows.


[image: image450]
If the condition is true, statements, 1, 2, and 3 will be executed. If the condition is false, the group of statements will not be executed, and the macro will continue at the statement following the End If statement. If you have multiple statements to execute when your If Then condition is true, always use the End If keywords to signify the end of the statements. 

If you want to specify a group of statements to perform if the condition is false, use the If Then Else form of the statement.


[image: image451]
In this case, if the condition is true, statements 1, 2, and 3 will be executed, and statements 4, 5, and 6 will be skipped. If the condition is false, statements 1, 2, and 3 will be skipped, and statements 4, 5, and 6 will be executed.

If you need more complex conditional structures, you can also nest If Then statements inside one another as shown below.


[image: image452]
In this example:

· If condition1 is true and condition2 is true, Statement 1 and Statement 2 will be executed, and everything else will be skipped. 

· If condition1 is true but condition2 is false, Statement 3 and Statement 4 will be executed. Everything else will be skipped.

· If condition1 is false and condition3 is true, Statement 5 will be executed. Everything else will be skipped.

· If condition1 is false and condition3 is false, Statement 6 will be executed, and everything else will be skipped. 

All of the logical operators in the following list can be used in the conditional statements.

	Not
	Inverses a logical value (Not True equals False and Not False equals True)

	=
	Tests for equality (X = Y will evaluate to true if X has the same value as Y)

	<>
	Not equals  (X <> Y will evaluate to true if X does not equal Y)

	<
	Less than (X < Y evaluates to true if X is less than Y)

	> 
	Greater than  (X > Y evaluates to true if X is greater than Y)

	>=
	Greater than or equal to (5 >= 5 is true; 5 >= 6 is false)

	<=
	Less than or equal to   (5 <= 5 is true; 5 <= 4 is false)


Iterating Through your Tasks
In programming terms, iteration involves the repetition of an instruction or a series of programming instructions. Programmers commonly refer to repeated iterations as loops. If you want to perform the same program statement or series of statements several times, iteration (a loop) is a great way to do it. In project macros, you can use iteration to perform a given action, test, or set of instructions on each task value in your Project. To iterate over your tasks, you must first declare a variable that can assume all of the attributes of a project task. This statement declares a variable called t as type Task.  XE "Visual Basic for Applications:Iterations" 
[image: image453.png]Dim t As Task




Now, look at the following Visual Basic statements:

[image: image454.png]For Each t In ActiveProject.Tasks
temp = t.Duration

total = total + temy

Next t




What follows is a line by line breakdown of this small section of code.

[image: image455.png]For Each t In ActiveProject.Tasks




The first statement says that the Tasks in the currently active project are going to be accessed one at a time, and that the Task currently being accessed will be represented by the variable t. 

(Remember, we declared t to be a Task variable.)

[image: image456.png]



This next line assigns the duration of the task that is currently being accessed (stored in the variable t) to the variable temp.

[image: image457.png]total = total + temp




This line adds the value in the variable temp to the value in the variable total. This sum is then assigned to the variable total.

[image: image458.png]Next t




The last line steps the iteration forward to the next task in the list and execution of the statements repeats. Now, the current task has advanced by one. This means that t will now represent the next task (now the current task) in the list of tasks.

The entire task list will be iterated (stepped through task by task), with the calculation in the third statement being repeated at each iteration (for each task). This will total up the duration values for every task in the project.

The following Visual Basic code is a Project macro that will iterate over all of the tasks in the project and total the values in the duration field.

[image: image459.png]Sub Macro ()
‘Declare Varisbles
Dim t ks Task

Dim total is Double
Din temp As Double

‘Iterate through each task in the project,
‘totaling the duration values
For Each t In hetiveProject.Tasks

temp = t.Duration

total = total + temp
Next t

‘Display a message box with the total duration value.

‘The term Str{{temp)converts the numerical "total” variable
'into a string so it can be displayed in the message box.
‘Notice that hen we use this term, quotation marks are not
‘required

HsgBox Str§(total), vhOKomly, "Total duraion for all tasks”

End sub




Please take notice of the message box statement near the end of the macro. This will display the total duration to the user.

The following image shows the task list for the Project.
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This next image shows the result of running the macro.
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You might notice that the total duration is 65640. Why is it so high? The answer is that the fundamental unit Project uses for duration is minutes. This figure represents the total duration from all of the tasks in the project has been calculated in minutes.
Section 5: Review Questions

11. What is a macro?

E. A small program

F. A collection of Visual Basic code statements

G. A way of automating tasks and actions

H. Any of the above

12. Why is macro security an issue?

E. It is not really an issue in most cases

F. Macros are always dangerous and shouldn’t be used

G. Macros have the potential to carry viruses, so precautions should be taken

H. Any of the above

13. Which one of the following statements is true?

E. You must know how to program to create a macro

F. Macros must be stored in the currently open project

G. You can assign a short cut key to a macro

H. Only Project 2007 allows you to create macros

14. Iteration is useful for…

E. Performing sequences of instructions repeatedly

F. Performing repeated calculations on the same variable 

G. Both of the above

H. None of the above

15. Which of the following statements is a valid comment in Visual Basic?

E. ‘ This line performs the average calculation

F. This is an IF Then Statement

G. The following code iterates through every task

H. The following Lines declare the variables for this macro

16. Which of the following is not valid Visual Basic?

E. Average = Average + 1

F. 1Average + 1 = 1Average

G. Dim Total as Integer

H. Dim Total as Double

17. Which two features can you use to copy macros from one file to another?

E. The Organizer XE "Project Organizer"  and the Project explorer

F. The Project Explorer and the Project Information dialogue

G. The Organizer XE "Project Organizer"  and the Task Pane

H. The Global Project file and the View menu

18. Which one of the following statements will create a message box?

E. Message Box ( “Title”, “Data”, “OK button”)

F. MsgBox Str$(temp), vbOKOnly XE "Visual Basic for Applications:vbOKOnly" , "Total"

G. MsgBox “Total”, vbOKOnly XE "Visual Basic for Applications:vbOKOnly" , "This is the Total"

H. B or C

19. What is the default trusted location for Project 2007

E. Your hard drive

F. The global project file

G. The current file

H. The shared network folder

20. Macros in the Global Project file are…

A. ADonalddeal with programmatic Accessr Good luck with Info





























































lways enabled

B. Never enabled

C. Enabled if they are digitally signed

D. You cannot store macros in the global file

Section 6: Analyzing Your Project

In this section you will learn:

· How to use scenario types
· How to use the PERT XE "PERT"  toolbar
· How to enter PERT XE "PERT"  values
· How to enter PERT XE "PERT"  weights
· How to calculate PERT XE "PERT" 
· How to view scenarios
· About Earned Value Analysis XE "Earned Value Analysis" 
· How to view EVA XE "Earned Value Analysis"  tables
· How to interpret EVA XE "Earned Value Analysis"  fields
· How to create an EVA XE "Earned Value Analysis"  report
Lesson 6.1: PERT XE "PERT"  Analysis

As your project begins to evolve and take shape, you will certainly want to evaluate your progress. This can be especially true in terms of forecasting how your project will turn out in the end.

One technique that can help with this is a PERT XE "PERT:Stands for"  analysis. PERT, which stands for Project Evaluation and Review Technique, is essentially a method of making educated guesses about your project’s outcome based on estimated information about your project tasks. Keep in mind, that the results of your PERT analysis will be directly related to how well you estimate the information (task durations) for your project.

With Project 2007’s PERT XE "PERT"  analysis tool, you can come up with a worst case, a best case, and a most likely case for how your project will be completed, based on the specific information that you provide.

Scenario Types
In Project 2007, there are three PERT XE "PERT:Scenario types"  scenario types.

· Optimistic: This scenario will reveal the best possible outcome for your project.

· Expected: This scenario will reveal the most probable outcome of your project.

· Pessimistic: This is a worst case scenario, which will reveal the worst possible outcome for your project.

When speaking of outcomes in the context of a PERT XE "PERT"  analysis, we generally are referring to durations. With this in mind, the Optimistic scenario will give us our best time estimate for the project, and the Pessimistic scenario will give us the longest (least desirable) time estimate for our project. The expected scenario will give an estimated duration that will probably be close to the actual case for the given project.

Using the PERT XE "PERT"  Toolbar
Microsoft Project provides a PERT XE "PERT:Toolbar"  toolbar to facilitate PERT analysis. To display the PERT toolbar, click the View menu, click Toolbars, and check PERT Analysis XE "Toolbars:PERT Analysis" . 
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You should then see the following toolbar:
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The following table contains a brief overview of what each button on the toolbar does.
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	Shows the best possible outcome for your project.
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	Shows the expected outcome for your project.
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	Shows the worst possible outcome for your project.
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	Recalculates the duration based on PERT XE "PERT"  fields.
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	Enter PERT XE "PERT"  values for the current task.
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	Enter PERT XE "PERT"  weights for the current task.
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	Switch to PERT XE "PERT"  Entry Sheet view.


Entering PERT XE "PERT"  Values
As mentioned previously, the quality of your PERT XE "PERT:Values"  analysis will depend on how well you estimate the information that you enter for your tasks. For PERT to work correctly, you must enter the optimistic, expected, and pessimistic durations for your tasks. 
The easiest way to do this for multiple tasks is to switch to PERT XE "PERT"  entry sheet view using the Views menu or the PERT toolbar. When you do this, you will see a window like the following:
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In this image, you can clearly see the fields where you enter the optimistic, expected, and pessimistic durations for each task. (Of course, the task names and the number of tasks that you have to enter data for will differ from project to project).

If you want to enter the same data for multiple tasks, select the tasks in question, and use the PERT XE "PERT"  entry form button on the PERT analysis toolbar.
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This action will display the PERT XE "PERT:Entry form"  entry form as shown below.
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Now you can use the PERT XE "PERT"  entry form to enter the durations for each scenario for the selected tasks. You can also use this entry form to enter scenario durations for individual tasks on a task by task basis.
Entering PERT XE "PERT"  Weights
By default, Project will assign weights to the three different scenarios discussed above. These weights are a way of mathematically stressing the relative likelihood of the three scenarios.

Project will assign a weight of one to the pessimistic and optimistic scenarios, and a weight of four to the Expected scenario. A good way to think of this is that if your tasks were repeated over and over many times, the Expected scenario would occur four out of six times (roughly a 67% chance), while the optimistic and pessimistic scenarios would each occur one out of six times (roughly a 17% chance), on average. This means that by default, Project considers the expected duration to be roughly four times as likely as either the pessimistic or optimistic duration (a good reason to refer to it as expected).

The degree to which these weights reflect the actual situation can vary from project to project. For this reason, Project 2007 allows you to adjust these weights to suit your particular situation.

For example, if you feel that your tasks have a good chance of finishing in the shortest possible duration, you may adjust the weight of the Optimistic scenario in the Set PERT XE "PERT:Weights"  Weights dialogue. To display this dialogue box, just click the PERT Weights button on the PERT toolbar.
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Clicking this button will display the dialogue as shown in the following image.

[image: image475.png]Task Name Duration  Optiistic Dur. | Expected Dur. | Pessimistic Dur.
Ottain Land 25 days? 0days. 0days. 0days,
Excvate Land 10 days? 0 ays. 0 ays.

Pour Faundation

Buid Frame. Set PERT Weights.

Enter weights for PERT calculstons.
These vakies must sum o 6

Duration Weights

Dptinistic:

Expected

Pessinistc





 Now, to increase the weight of the Optimistic (shortest duration) scenario for your tasks, enter a higher number than one (the default value) in the field provided. If you change this number and click OK without changing the weights for one or both of the other scenarios, you will see the following alert.
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The scenario weights must always add up to 6. In the example shown here, we have Optimistic = 2, Expected = 4, and Pessimistic = 1, for a total of seven. Basically, if you want to give the optimistic scenario a weight of 2, you will have to make the weights of the expected scenario and the optimistic scenario sum to 4. (Optimistic=2, Expected=3, Pessimistic =1) Whatever the particular case may be, you do have some flexibility to weight the scenarios in a way that best reflects the realities of your specific situation.  XE "PERT:Weights" 
(Note that when you change the scenario weights, the new weights will be applied to all tasks in the Project.)

The specific calculations involving scenario weight settings will be discussed in the following paragraphs.

Calculating PERT XE "PERT" 
The next step after entering your PERT XE "PERT:Calculating"  values (and possibly adjusting the PERT weights) is to perform the actual PERT calculations. Once you perform the PERT calculation, you will be able to view the different scenarios as Gantt charts.

To calculate PERT XE "PERT:Warning" , just click the Calculate PERT button on the PERT toolbar.
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When you click this button, you will see the following warning.
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This text is telling you that the initial duration for your tasks will be reset to new values based on the entries in the Optimistic, Expected, and Pessimistic duration fields. In addition, the PERT XE "PERT"  analysis will overwrite the first three Start/Finish fields. If Microsoft Project encounters any scheduling conflicts, you will be notified. To proceed, just click the Yes button at the bottom of the alert box.

As an example of how the PERT XE "PERT:Equations"  calculation works, suppose that you have a task with duration of 11 days. The optimistic duration for the task is 5 days, the expected duration for the task is 10 days, and the pessimistic duration for the task is 15 days. 

Now, lets assume that the default weights (Optimistic =1, Expected=4, and Pessimistic =1) apply. Project will calculate the duration for this task with the following equation:


[image: image479]
In this case, we have (1×5 + 4×10 + 1×15) ÷ 6, or 60 ÷ 6, which, of course, equals 10. 
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The image above shows a list of tasks before the PERT XE "PERT"  calculation is performed. The task in the red rectangle has the scenario durations described in the example above.
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Here is the same task list after the PERT XE "PERT"  calculation. The task durations have been recalculated based on the duration scenarios and the PERT weight settings. You should notice that now, the task we were looking at has a duration of 10 days.

If you feel that a particular task has an original duration that you are certain of, just enter this duration value into all three of the duration scenario fields. If you do this, the PERT XE "PERT"  calculation will not change the original duration value (regardless of the PERT weight settings). Look at the equation discussed above and see if you can figure out why.

Viewing Scenarios

Once the PERT XE "PERT:Gantt charts and"  calculations are complete, you can view the various scenarios using the buttons on the PERT Analysis toolbar. For example, to view the best case scenario, simply click the Optimistic Gantt button.
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Here is an image of the optimistic (best case) scenario for a small project.
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To view the expected duration, just click the Expected Gantt button on the toolbar.
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The following image shows the expected scenario for the same project as shown above.
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Finally, if you click the Pessimistic Gantt button, you will see the pessimistic duration of the project.
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You should also note that because the original durations have been recalculated as a weighted average of the PERT XE "PERT"  durations, the original Gantt chart (View – Gantt chart) can change from its previous state.
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(Before the PERT XE "PERT:And durations"  analysis, task number one had duration of 2.5 days).

As you can see, the PERT XE "PERT"  tools will give you the power to estimate the duration of your tasks (and your project as a whole) even if you do not know specifically how long your tasks will take to complete. You just have to provide a value for the shortest possible duration, an expected duration, and the longest possible duration. PERT can then calculate scenarios and durations for your tasks based on this information. 

Lesson 6.2: Earned Value Analysis XE "Earned Value Analysis" 

Project 2007 provides still another way to track and analyze your project’s performance. The Earned Value Analysis XE "Earned Value Analysis"  feature will help you compare your original project plan with what has actually been done, to help you find out if your costs, task completion, and schedule are progressing as you originally planned. 
About EVA XE "Earned Value Analysis" 
Project’s Earned Value Analysis XE "Earned Value Analysis:Data required"  (EVA XE "EVA" \t "See Earned Value Analysis" ) features can help you view a project’s actual and planned cost and work, and the variances between the two. It can also show you schedule variances.
Basically, Project looks at the following four entities when calculating EVA XE "Earned Value Analysis" :

· Your project baseline

· Your actual work and costs

· The variances between baseline data and actual data

· The status date (as specified in the Project Information dialogue)

By this time, you should already know how to save a baseline for your project and how to enter actual data, so let’s proceed by getting right into the subject of EVA XE "Earned Value Analysis" .

Viewing EVA XE "Earned Value Analysis"  Tables

In Project, you can view the Earned Value Analysis XE "Earned Value Analysis:Tables"  for either tasks or resources. To view the EVA XE "Earned Value Analysis"  for resources, make sure that you are in Resource Sheet view. To view the EVA XE "Earned Value Analysis"  for tasks, make sure that you are in a task sheet (like the Task Entry table for example). For our purposes, we’ll stick with viewing the EVA XE "Earned Value Analysis"  for tasks. 

You may also want to set a Project Status date by clicking the Project menu, followed by the Project Information button. You can than specify a status date in the Project information dialogue which will be used as a cut-off point for the EVA XE "Earned Value Analysis"  (as EVA XE "Earned Value Analysis"  will be calculated up to the Status date). By default, the Project status date will be the current date, unless otherwise specified.  XE "Earned Value Analysis:And Project Status date" 
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Remember to click the OK button to implement any change that you make.

Next, click the View menu, click Table, and click More Tables. Now, you can choose from one of the three EVA XE "Earned Value Analysis"  tables available.
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· The “Earned Value” table will give you an overview of the work, cost, schedules, and estimates for your tasks.  XE "Earned Value Analysis:Tables" 
· The “Earned Value Cost Indicators” table will focus more on cost budgets, variances, and estimates.
· The “Earned Value Schedule Indicators” table will focus on schedule budgets and variances.
The following image shows an example of a basic “Earned Value” table.

[image: image491.png]1
12

Task Name:

htain Land

Excavate Land
Install basic s
Pour Faundation

Bl Frame.

External Walls and Roof
Install Plambing

Instal Electrical

Install Insulstion

Fiish iterior

Painting

Landscaping

Planned | Earned
Value-PV | Value-EV.
(BOWS) | (BEAP)
$1.30000 §1,08333
450000 $4,50000.
158400 §1,55400
144000 §1,44000.
592000 $32000
150000 §1,50000.
$140000  $70000.
$140000 340443
532000 $288.00
50000 $30000
59800 $3800
351000 $51000

AC (ACHP)

5130000
485000
184500
144000
92000
$1.50000
$142000
384000
528800
360000
596.00
351000

sV

(521667)
5000
5000
5000
5000
5000

(5700.00)

(9995.58)

(53200)

(5200.00)
5000
3000

v EAC

(621857) 3156000
(315000) 3455000
(526400) 3184300

5000 §1,44000
5000 $32000
000 §1,50000
(942000) 3224000
(5320558) $1250080
5000 §32000
(530000) 3100000
5000 345000
3000 $1 20000

BAC

5130000
5450000
$1584.00
144000
92000
$1.50000
$1.40000
$1.40000
32000
350000
48000
$1 20000

WAC

(5260.00)
(3150.00)
(5264.00)

5000

5000

5000
(9840.00)
(511,20081)
5000
(§500.00)
5000

3000

Procurment offcer
i%ifmmr

Utities workers

Concrete worker
Framer





Here is a closer view of the table itself.

[image: image492.png]Task Name

htain Land 5130000

Excavate Land
Install basic s
Pour Faundation

Bl Frame.

External Walls and Roof
Install Plambing

Instal Electrical

Install Insulstion

Fiish iterior

Painting

Landscaping

Planned  Earned
Value-PV | Value-EV.
(BOWS) | (BEAP)
9108333
450000 $4,50000.
158400 §1,55400
144000 §1,44000.
592000 $32000
150000 §1,50000.
$140000  $70000.
$140000 340443
532000 $288.00
50000 $30000
59800 $3800
551000 951000

AC (ACHP)

5130000
485000
184500
144000
92000
$1.50000
$142000
384000
528800
360000
596.00
51000

sV

(521667)
5000
5000
5000
5000
5000

(5700.00)

(9995.58)

(53200)

(5200.00)
5000
5000

v

(521667)
(3150.00)
(5264.00)

5000
5000
5000
($420.00)
(53.29558)
5000
(5300.00)
5000
5000

EAC

5155000
485000
184500
144000

92000
$1.50000
5224000

1260061

32000
100000

348000
120000

BAC

5130000
5450000
$1584.00
144000
92000
$1.50000
$1.40000
$1.40000
32000
350000
48000
120000

vaC

(5260.00)
(3150.00)
(5264.00)

5000

5000

5000
(9840.00)
(511,20081)
5000
(§500.00)
5000

5000




Clearly, there is a lot of information presented here. The question now becomes, how do we interpret the data in the EVA XE "Earned Value Analysis"  table? 

A good start to answering this question is to understand what the different field names (column headings) mean. 
About the EVA XE "Earned Value Analysis"  Fields
Before we can really understand what the EVA XE "Earned Value Analysis"  table is telling us, we must understand what the column headings in the table mean. The following chart shows what the EVA XE "Earned Value Analysis"  column headings stand for, and what the values in the fields show.  XE "Earned Value Analysis:Fields" 
	Abbreviation
	What it stands for
	What it shows
	Formula

	BCWS
	Budgeted Cost of Work Scheduled
	This is what should be spent (baseline) on a task up to the status date.
	N/A

	BCWP
	Budgeted Cost of Work Performed
	The cost of work corresponding to % completed on the task, according to the original budget (baseline).
	N/A

	ACWP
	Actual Cost of Work Performed
	The sum of all costs for work performed on a task to date.
	N/A

	CV
	Cost Variance
	The difference between how much was budgeted for the task’s performed work (BCWP), and how much the task actually costs (ACWP).
	    BCWP - ACWP



	SV
	Schedule Variance
	The difference between how much was budgeted for the task’s performed work (BCWP), and how much the task should cost according to budget (BCWS).
	    BCWP – BCWS



	CPI
	Cost Performance Index 
	Ratio of budgeted cost to actual cost. More than one means you’re under budget; less than 1 means you’re under budget.
	    BCWP ÷ ACWP

	EAC
	Estimate at Completion

(also known as Forecast at Completion)
	Project’s estimate of how much the task will cost when it is done.
	ACWP+(BAC-BCWP)

CPI

	BAC
	Budgeted at Completion
	The budgeted amount that the task will cost when it is done.
	Derived from Baseline Cost field

	VAC
	Variance at completion
	Difference between actual and baseline costs at completion (BAC-EAC).
	      BAC - EAC



	SPI
	Schedule Performance Index
	Ratio of budgeted schedule to actual schedule. More than one means you’re ahead of schedule; less than 1 means you’re behind schedule.
	BCWP ÷ BCWS

	CV%
	Cost Variance Percent
	The difference between budgeted task cost and actual cost to date.
	[(BCWP-ACWP)/BCWP] x 100

	SV%
	Schedule Variance Percent
	Percentage that you are ahead of, or behind, schedule.
	[SV/BCWM] x 100



	TCPI
	To Complete Performance Index
	Ratio of work to be completed to money still budgeted.
	   (BAC-BCWP)
÷ (BAC-ACWP)

	PPC
	Physical Percent Complete
	A value you can enter that will override % Complete.
	N/A


Let’s look at an example to clarify the use of these EVA XE "Earned Value Analysis"  fields further. Here is the Gantt chart for a basic project. Let’s look at the task named Install Plumbing.
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You should notice from the Gantt chart that the task is about 50% complete. The image below shows the Tracking Gantt for the Project. 
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Here you can see that the baseline duration (grey bar) is significantly shorter than the actual duration (blue bar). The information we have seen so far tells us that the task duration has exceeded the original baseline estimates, and still the task has not been completed.

Now let’s look at the EVA XE "Earned Value Analysis"  table for this project.
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The first column contains BCWS values. From the table, you can see that the BCWS value for task 7 is $1400. This means that the planned cost for this task according to the baseline is $1400.

In the next column you will see the BCWP values. For task number 7 the value in the second column is $700. This means that the task, budgeted for $1400, has only been completed to the $700 dollar mark, based on the original budget. (This is because the task is only about 50% complete.)

In the ACWP column, we see that the value is $1120. This means that actual cost of the work performed (about 50% complete) is $1120. This is because the task has run overdue, that is, it has taken longer to reach the 50% complete mark than it should have. Because it has taken longer, more work related costs have accumulated. Therefore, the actual cost of work performed is higher than the budgeted cost of work performed (BCWP).

In the CV field, you can see the difference (variance) between how much was budgeted for the current level of completion of the task and how much it actually has cost to get to the current level of completion for the task. Remember, negative values are shown in parentheses, so the CV field value for task number 7, which is ($420), is a negative value. This means that the actual cost of the work done to the current completion level is higher than the budgeted cost of the work done to the current completion level. If the CV value was positive, we would be getting the work done for less than what was budgeted.

To add additional EVA XE "Earned Value Analysis"  fields to the table, you can right click on one of the column headings, and choose Insert Column from the menu.
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In the resulting Column Definition dialogue, select the desired EVA XE "Earned Value Analysis"  field from the list of available column headings and click the OK button.  XE "Earned Value Analysis:Adding fields to Task Entry" 
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Reporting EVA XE "Earned Value Analysis"  Results

Project 2007 provides a way to quickly generate a report outlining your project’s EVA XE "Earned Value Analysis" . To do this, first click the Report menu and then click the Reports option.  XE "Earned Value Analysis:Reports" 
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In the resulting dialogue, double click the Costs option.
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In the Cost Reports box, click on the Earned Value option, and then click the Edit button to edit the report, or the Select button to view it.
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If you click select, you will display the EVA XE "Earned Value Analysis"  report in the Print Preview window.
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Remember, you can use the Page Setup button to make changes to your report before you print it. 

Section 6: Review Questions

11. PERT XE "PERT"  stands for…

E. Program Evaluation and Review Technique

F. Project Evaluation Resource Table

G. Project Error Report Table

H. None of the above

12. EVA XE "Earned Value Analysis"  stands for…

E. Extra Value Added

F. Earned Value Analysis XE "Earned Value Analysis" 
G. Earned Valid Amounts

H. Earned Value Added

13. The PERT XE "PERT"  calculation calculates a….

E. Average

F. Weighted average

G. Geometric mean

H. Median

14. BCWP stands for….

E. Basic Cost Work Pricing

F. Budgeted Costs Without Payment

G. Budgeted Costs for Work Performed

H. None of the above

15. ACWP stands for…

E. Actual Costs Without Payment

F. Accelerated Costs for Work Paid

G. Accumulated Work Performed

H. None of the above.

16. A value in the CV field of an EVA XE "Earned Value Analysis"  table is the difference between…

E. BCWP and SV

F. ACWP and BCWS

G. ACWP and BCWP

H. None of the above

17. In a PERT XE "PERT"  analysis All Pert weights must add up to…

E. 4

F. 10

G. 12

H. 6

18. The PERT XE "PERT"  weights are applied to the…

E. PERT XE "PERT"  resources

F. Duration Scenarios

G. Start Dates

H. Fixed Costs

19. Which of the following is the best selection of PERT XE "PERT"  weights if you favor a pessimistic view?

E. Optimistic 3 Expected 2 Pessimistic 1

F. Optimistic 3 Pessimistic 3 Expected 0

G. Optimistic 3 Pessimistic 4 Expected 1

H. Optimistic 1 Expected 2 Pessimistic 3

20. What value would you use for a PERT XE "PERT"  weight if all scenarios were equally likely?

E. 3

F. 6

G. 2

H. 5

Section 7: Expert Topics

In this section you will learn how to:

· Modify an existing form
· Use the Edit menu
· Use the Item menu
· Create your own form
· Open the Organizer XE "Project Organizer" 
· Copy file elements
· Rename elements
· Delete elements
· Use the Custom Forms toolbar XE "Toolbars:Custom Forms" 
· Insert objects into a project
· Import data from Outlook XE "Microsoft Office Outlook" 
· Export data to Outlook XE "Microsoft Office Outlook" 
· Save a project as XML XE "XML" 
Lesson 7.1: Working With Forms

Project 2007 provides a special set of interface components called forms. These forms allow you to enter specific types of resource or task related information. If you select a task (or resource) from your project, and then select a particular form, you will see the specific data from that task or resource in the form’s fields. If you wish, you can edit the data in the form, or use the form to make new entries.

In addition, Project 2007 allows you to edit (customize) a form if it does not meet your needs. Moreover, you can even build your own form from scratch if you really want to be creative.

In this lesson we will discuss the Custom Forms XE "Custom Form:What is?"  toolbar XE "Toolbars:Custom Forms" , how to modify a form, and how to build your own custom form.

The Custom Forms Toolbar

In Project 2007, if you click the View menu followed by the Toolbars option, you should see a Custom Forms option.
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If you click the Custom Forms command XE "Toolbars:Custom Forms" , a toolbar like the following will appear on your screen.  XE "Custom Form:Toolbar" 
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The first button on the left of the toolbar is the Entry Form button.
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Clicking this button will display the following form.
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The fields on this form display some basic information for the selected task. You can edit the values in these fields, or enter new values. To apply any changes you make to the selected task, click the OK button.

The next button on the Forms toolbar will display the Cost Tracking Form.
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Once again, you can edit the values in this form or enter new ones if you wish. 
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As before, click OK to implement your values for the selected task.

The work tracking button is shown in the red square below.
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That command will display the following form:
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The Task Earned Value button triggers a form that will display EVA XE "Earned Value Analysis"  (Earned Value Analysis XE "Earned Value Analysis" ) data for the selected task.
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The Schedule Tracking button is fourth from the right:
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It will display the following form containing information on the variance in start and finish times (as measured from the baseline).
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The Task relationships button is the next command:
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It reveals a form that gives the Id number of any predecessor or successor task to the selected task.

[image: image515.png]Task Relationships.

Predacessars:
B

Successars:
3





If you change the ID number of the Predecessor or Successor task in the form, the links on the Gantt chart will change to reflect the new dependencies. To create multiple predecessors or successors, enter the multiple task ID numbers separated by commas.

The Tracking form button is second from the right.

[image: image516.png]



It will reveal a form like the following.
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The last button is the Forms button.
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If you click it, you will see the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue"  box.

[image: image519.png]Customize Forms.

Eorms: @ Task  OResource

Cost Tracking
Earned Value
Entry

PERT Entry
Schedue Tracking
Task Relatianships
Tracking

iark Tracking





We will discuss this dialogue in more detail in the concepts that follow.

Modifying a Form

To modify a form, you should first display the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue" . To do this click the Forms button ([image: image520.png]


 ) on the Custom Forms toolbar XE "Toolbars:Custom Forms" . When the dialogue appears, you can select the form that you want to modify and then click the Edit button.  XE "Custom Form:Creating from existing" 
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In the previous image, we have selected the Entry form to edit. When you click the Edit button you will see a screen like the one on the following page.
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In the upper left you will see a small menu bar, and in the middle of the screen you will see the form in question. You can use the menu options to modify the form in several ways if you wish, but in practice, it is probably better to make a copy of the form and modify that. If you work with a copy, you will not damage the structure of the original form (in case you want to preserve the original). 

To create a copy, select the form that you want from the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue"  as before, and then click the Copy button.  XE "Custom Form:Creating from copy" 
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When you perform this action, you will see a small dialogue with fields for entering a name, and a shortcut key for the modified form.
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Once you are ready, click the Ok button to create the copy of the form. You will then see the Edit screen, with the menu bar on the top left, and the copied form in the large grey area of the screen.
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Everything is now in place for you to begin making your modifications.
Using the Edit Menu
One of the menus in the top left of the Form Editor is the Edit menu. If you display the Edit menu, you will see the options shown in the following image.  XE "Custom Form:Setting form information" 
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If you click the Information option, a small dialogue will appear with fields for the width and Height of the Form, and the X and Y coordinates that determine its position on the screen.
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By changing the values in these fields, you can modify the form’s dimensions and its screen position.

The following image shows the copied form (named MyCopy) after the size and position values have been modified.
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The second option on the edit menu is called “Repeat Last Move.”  XE "Custom Form:Repeating move" 
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If you move the form into position by dragging the title bar with your mouse, clicking the Repeat Last Move option will relocate the Form once again. It does this by changing the forms X and Y coordinates by the same amount that they were changed by the previous move.

If you click the last option on the Edit menu (Select Dialogue), the form will be selected, and you will see position and size data in the status bar at the bottom of the screen.  XE "Custom Form:Selecting" 
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You can also select the form by clicking on it with your mouse.

Using the Item Menu
On the toolbar next to the Edit menu, you will see an Item menu.  XE "Custom Form:Adding controls" 
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This menu contains a list of controls that you can add to the form. To add a control to the form first click on the type of control you want in the Item menu. As an example, let’s add a new Field to our copied form. First, we will click on the Fields option in the Item menu.
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This action will display the following dialogue:
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Here you can specify the X and Y coordinates of the field (with respect to the form), as well as the Width and Height of the field. If you click the “Show as Static Text” checkbox, the value that the field contains will be displayed on the form, but it will not be editable. 

You can choose the field that you want to display on the form by selecting it from the drop list provided, as shown in the following image.
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Once you have chosen the field you want on your form, click the OK button at the bottom of the Item information dialogue to add the item to the form at the specified coordinates.
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If you click on this new field to select it, you can drag with your mouse it to another position in the form.
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Here you can see the Resource Names field and the dashed lines indicating its new position.

If you select the Text option from the Item menu, you can add a text label to the form (to identify the new field).
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When you choose this option, the word “Text” will appear on the form.
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If you double click on the word “Text” in the form, a dialogue will appear that allows you to edit what the text label will say.
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When you click the OK button in the dialogue, the text label that you created will appear on the form. You can then select this text label by single clicking it, and proceed to drag it with your mouse to whatever location on the form that you want.
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In addition to text labels and fields, you can also add buttons and group boxes to your form. Group boxes are used to group control items together and buttons are used to add either an OK or Cancel option to your Form. (If your form already has an OK button and a Cancel button, you will not be able to add any buttons.)  XE "Custom Form:About buttons" 
Once you have finished modifying your form, choose the File menu and click the Save option to save the form.

[image: image541.png]Eie | Edt Item

Save

i





Once your from has been saved, click the Exit option to exit from the Edit screen.

You will now see your modified form in the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue" .
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To use the form, select it in the dialogue and click the Apply button. 

You will then see the form appear on your Project screen, at the size, width, and position that you specified.
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Creating your Own Form

You have just learned about modifying a form by using the Edit and Item menus. You should also know that Project 2007 allows you to use the same tools to create a form from scratch.

To create your own form, display the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue"  as before.  XE "Custom Form:Creating from scratch" 
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This time, click the “New” button in the upper right of the dialogue to display the Define Custom Form dialogue.
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Specify a name and a shortcut key for your new form and then click the OK button. (If you choose a shortcut key that is already in use, Project will let you know.)

Next, you will see the Edit screen with a blank form available for you to customize as you see fit.
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Use the Edit menu and the Item menu as discussed previously to set up the size, position, buttons, fields, and text labels for your form.

Once you are ready, use the File menu to save your form, and then click the Exit option to return to the Project screen.

You can then open your new form by double clicking it in the Customize Forms Dialogue.
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Here is a sample of a custom form created from scratch.
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Lesson 7.2: Using the Organizer XE "Project Organizer" 

When you modify, copy, or create forms, they are stored in the current project file. Sometimes when you create macros you may also choose to store them with the current project. Though sometimes convenient, the problem with this strategy is that the modified or custom forms and macros are stored with their respective projects, and are not accessible across all of your projects.

For a form or macro to be accessible to all of your Projects it must be stored in the Project global file. Fortunately, Project 2007 provides a tool called the Organizer XE "Project Organizer"  that can help you deal with this.
Opening the Organizer XE "Project Organizer" 
To open the Organizer XE "Project Organizer:Opening" , display the Tools menu and then click the Organizer XE "Project Organizer"  option.
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This action will display the Organizer XE "Project Organizer"  dialogue.
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You can also display the Organizer XE "Project Organizer:Opening"  from the Customize Forms dialogue XE "Custom Form:Customize Forms dialogue" . First, display the Forms dialogue by clicking the Forms button on the Custom Forms toolbar XE "Toolbars:Custom Forms" .
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When the Forms dialogue appears, just click the Organizer XE "Project Organizer"  button.
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If you open the Organizer XE "Project Organizer"  this way, the Forms tab will be displayed automatically.
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Copying Project Elements
When you display the Organizer XE "Project Organizer:Copying elements"  dialogue, you will typically see two data areas or panes. One area will be for the source file, while the other area is for the Global.MPT project file. By default, the Global pane will always be the one on the left. 

The pane for the source file will contain a list of elements belonging to the source file that you can choose from. The source file itself is usually the project that you are currently working with; however, you can choose any currently open Project file to be the source file by selecting it from the list provided in the field underneath the source file pane.
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You will notice from the image shown above that the Global.MPT file is also available in the drop list. You could choose the global file for the pane on the right, and choose any of the other Project files available for the Pane on the left if you wanted.

If you look at the Copy button at the top middle of the dialogue, you will see some direction indicators on it.
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If an item is selected in one pane, the direction indicators on the Copy button will point to the other pane. In the image above, an Item is selected in the Global pane. If you clicked the Copy button, the item would be copied over to the other (source file) pane. We will call this the source pane because typically, items are copied from this pane over to the Global Pane (from the source file over to the Global file). Since items in the Global File are generally accessible to all Projects, it makes little sense to copy them from the global file to the other files.

If we select an item in the source file pane, the direction indicators on the Copy button will point towards the Global file.
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Now, if you click the Copy button, the selected item will be copied over to the Global file. Once in the Global file, it will be accessible to any open project.

You can choose the category of item that you want to put in the Global file by selecting the corresponding tab in the Organizer XE "Project Organizer:Tabs"  dialogue.
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As you can see, you can use the organizer to transfer Views, Forms, Calendars, Filters, Reports, Modules, and more, over to the Global file. 

If you wanted to copy macros between Project files, you would select the Modules tab.
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Under the modules tab, you can view the code modules (containing the macros) for the selected projects. You can use the Copy button to copy modules (containing macros) between Project files. 

Renaming Elements with the Organizer XE "Project Organizer" 
It is easy to rename an element with the Organizer XE "Project Organizer:Renaming elements"  dialogue. Just select the element that you want to rename, and then click the Rename button.
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Once you click the Rename button, a small box will appear with a field that you can use to enter a new name for the selected item.
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When you click the OK button, the item will appear in the Organizer XE "Project Organizer"  under its new name.
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Deleting Elements
The process of deleting elements with the organizer is a simple matter. To delete an element, just choose the appropriate tab. Then select the source file, followed by the element that you want to delete.
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Next, click the Delete button in the dialogue to delete the selected item. You will then see an alert box asking if you are sure.  XE "Project Organizer:Deleting elements" 
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If you are certain you want to delete the selected item, just click the Yes button and it will be deleted.
Lesson 7.3: Using Project with other Applications

As you already know, you can use Project to import and export data to and from other application files (like Excel). In addition to being able to import and export to and from many file types, Microsoft Project 2007 also provides tools that allow you to interact with other applications.
In this lesson, we’ll look at using Project with Microsoft Outlook XE "Microsoft Office Outlook" , inserting objects from within Project, and saving your project as an XML file.
Inserting Objects

Like many other Microsoft applications, Project 2007 has capabilities for Object Linking and Embedding XE "Object Linking and Embedding"  (OLE). This allows you to insert files that were created in other applications into Project. The power of this technique comes from the ability of objects to retain their original format and their links to the original application, meaning that they can easily be edited.

If you wish, you can insert an object directly into the Project screen, or you can attach it to a task or resource using the Notes field. The Notes method has the advantage of keeping things more organized, so this is the method that will be discussed first.
To insert an object into your task or resource, first open the task or resource’s information dialogue and click the Notes tab. When the Notes tab opens, click the Insert Object button.
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Next, you will see an Insert Object dialogue which will allow you to create a new object; or create an object from an existing file. For the purposes of this discussion, we’ll create an object from an existing file. 
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 To create an object from an existing file, we will have to select the Create from file radio button at the top left of the dialogue. When you choose to create an object from an existing file, you will see a Browse button and a Link checkbox.
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You can use the Browse button to navigate to the location of the file you want to insert as an object. If you put a check in the Link checkbox, you will create an active link to the file in question. You will also notice a “Display as Icon” checkbox. If you do not put a check in this box, a picture of the file’s contents will be inserted into the notes. Once you click the OK button, the object will be inserted.
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The image above shows an inserted file with the “Display as Icon” checkbox empty. If you double click on the picture of the file contents, the file will open in the application that created it. Remember to click the OK button to implement the insertion of the object.

The following image shows what the Notes tab looks like when the Display as Icon checkbox has been selected.
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If you open an inserted object by double clicking it in the Notes tab, it will open in the application that created it. If you chose to link the object (put a check in the Link checkbox in the “Insert Object” dialogue), any changes you make to the open object will be preserved in the underlying source file, and vice versa. If the Link checkbox was left clear, changes to the open object will not be preserved in the underlying file (as they will not be linked). 
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Here you can see the inserted object after it has been opened. It opens in the application that was used to create it (in this case, Excel).

Here are some tips for using objects in Project:

· If you’ve received a project from someone else, be careful about opening objects as they can be harmful to your computer.

· If you’re opening an object created by someone else, you may get an error if you don’t have the application that was used to create it installed on your computer. 

· You will get an error if you try to access an object in a place that does not exist, or that links to a file that has been moved or deleted.

· If you’re sending a project to someone else, make sure that any linked files are accessible from a central location. For example, if your object’s path is C:\Bob’s Stuff\Document.doc, and you send your project to Sue, she will not have that folder or that file, and will receive an error when she tries to open the object. However, if the file is not linked to the object (the link checkbox was empty), the object will open even if the path to the original file has changed, or even if the source file has been deleted.

To insert an object directly into the Project screen, click the Insert menu and then click the Object option.
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Performing this action will display the Insert Object dialogue as before. The process is essentially the same as before, except that when the inserted object appears, it will show up on your Project screen.
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To remove the object, right click on it and select Delete from the pop up menu. You can also single click on the inserted object to select it, and then drag it to the position of your choice.
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Importing Data from Outlook XE "Microsoft Office Outlook" 
Many people use Microsoft’s information management program, Outlook XE "Microsoft Office Outlook" , to manage e-mail, time, and tasks. Luckily, it’s easy to import information from Outlook XE "Microsoft Office Outlook"  to Project. This can be particularly useful if you’re just starting to use Project.

To start, click the Tools menu and click Import Outlook XE "Microsoft Office Outlook"  Tasks.
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You will then see a dialogue listing your Outlook XE "Microsoft Office Outlook"  task folders and the tasks in each of them. 
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You can use the checkboxes on the left hand side to choose which tasks to import. Once you have made your selections, click the OK button. The task or tasks you selected will now appear in Project. 
Although task notes will be preserved, recurrences will not. Also, you should remember that Outlook XE "Microsoft Office Outlook" ’s reminder feature does not work in Project.
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As soon as the tasks are imported into Project, you can edit, move, or delete this task just like you would any other.

Exporting Data to Outlook XE "Microsoft Office Outlook" 
Unfortunately, it’s not as easy to export tasks or calendar information from Project to Outlook XE "Microsoft Office Outlook"  as it is to import information from Outlook XE "Microsoft Office Outlook"  to Project.

To export data from Project to Outlook XE "Microsoft Office Outlook" , you will have to use an intervening file type to hold the Project data. Outlook XE "Microsoft Office Outlook"  can import data from many types of files, including Excel files and CSV files.

To get the data from Project into Outlook XE "Microsoft Office Outlook" , you should first export it to an Excel file or a CSV file) using Project’s Export Wizard. To do this, just use Project’s Save As dialogue to save the file in the appropriate format.
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Saving a file in this way will invoke Project’s Export wizard automatically. (The Import and Export wizards are discussed in the Project 2007 Advanced manual, Lesson 2.4.)

Once you have created your file containing the relevant Project data, you can use Outlook XE "Microsoft Office Outlook" ’s Import feature to import the data from the file.
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This command will start Outlook XE "Microsoft Office Outlook" ’s Import and Export wizard. First, choose to import from another program or file.
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And then choose the specific file type that you will import from.
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Next, you will need to browse to the file. Your tasks should then appear in Outlook XE "Microsoft Office Outlook" .

Saving a Project as XML XE "XML" 
The XML XE "XML"  file format is a very open file specification that allows developers to communicate data, along with its hierarchical structure, between programs. Because XML uses a flexible tag style format that looks something like HTML XE "HTML" , it is convenient for developers to use XML as a means of tailoring or customizing data exchange to the specific needs of a situation. For these reasons and more, XML files are playing an increasingly important role in exchanging information over the web.

To save your Project data in XML XE "XML"  format, first display the Save As dialogue (File – Save As). Once the dialogue is displayed, give Project the file a name, and choose XML format from the drop list in the Save As Type field.
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When you are ready, click the Save button to save the file.

Here is a brief excerpt from an XML XE "XML"  file created from within Project 2007.

[image: image581.png]<7uml version="1.0" encoding="UTF-8" standalone="yes" 7>
- <Project xmins="http://schemas.microsoft.com/project">
<Saveversion>12</Saveversion>
[EName>EVAtest.xmi</Nare>

[«Company>The Kennel</Company>
[cauthor>Bobe/authors
[¢CreationDate>2006-09-04T12:08:00</CreationDate>
[¢LastSaved>2006-10-04T15:42:00</LastSaved:>
<SchedulsFromstart> 1</5chedueFromStart>
<StartDate>2006-09-04T08:00:00</5tartDate>
<FinishDate>2007-01-23T17:00:00</FinishDate>
<FYStartDate>1</FY5tartDate>
<CriticalslackLimit>0</CriticalSlackLimit>
<CurrencyDigits>2</CurrencyDigits>
<CurrencySymbol>$</CurrencySymbol>
<CurrencyCade>USD</CurrencyCade>
<CurrencySymbolPosition>0</CurrencySymbolPositions
<CalendaruiD>1</CalendaruiD>
<DefaultStartTime>08:00:00</DefaultStart Times
<DefaultFinishTime>17:00:00</DefaultFinishTimes
<MinutesPerDay>480</MinutesPerDay>
<MinutesPerieek>2400</MinutesPerweeks
<DaysPerMonth>20</DaysPerhonths

<Default TaskType>0</DefaltTask Types
<DefaultFixedCostaccrual></DefaultFisedCostaccrual>





You can see that the name of the file, the Company name, the username of the Project’s creator, the creation date, and the date last saved are included as metadata in the XML XE "XML"  file. This kind of information is practically identical to what you would see in the Project file’s properties dialogue.

The remainder of the file would include the rest of your project data and hierarchical information stored according to a specific XML XE "XML"  format designed for communicating Project data. Developers can create software that interprets/parses this kind of file exactly as they require.

If you imported an XML XE "XML"  file like this into the Project 2007 application (using the Open dialogue), the import wizard will seamlessly build the Project file from the data and hierarchical information stored in the XML code. 

Note that Project 2007 does not provide functionality for saving a Project as a web page.
Section 7: Review Questions

11. To view the Custom Forms toolbar XE "Toolbars:Custom Forms"  you should…

E. Choose Views – Tables – Forms

F. Choose View – Toolbars – Forms Editor

G. Choose View – Toolbars – Custom Forms

H. Open the Visual Basic Editor XE "Visual Basic Editor" 
12. Which one of the following cannot be added to a custom form?

E. Field

F. Text Label

G. Button

H. Chart

13. You can use the Organizer XE "Project Organizer"  to ….

E. Delete Forms

F. Debug Macros

G. Save Task Notes

H. Set Macro Security

14. If a Form is stored in the Global Project file you can…

E. Use it only in one project

F. Use it in multiple projects

G. Use it once only

H. None of the above

15. When you insert an object into a project you….

A. Must use the application that created the object to edit your project

B. Can insert a link to the object or the object itself

C. Can link the object to its source file

D. B and C

16. When you edit an inserted object …..

E. You can use the application that created it

F. You can use any application

G. You can’t use the application that created it

H. None of the above

17. XML XE "XML"  is most similar in structure to what other language?

E. JAVA

F. C++

G. HTML XE "HTML" 
H. VISUAL BASIC

18. Which of the following statements is not true when it comes to Project 2007?

E. You can save a Project file as a template

F. You can save a Project file as a web page

G. You can save a Project file as an XML XE "XML"  file

H. You can import tasks from Outlook XE "Microsoft Office Outlook" 
19. In Project, you can insert objects from which of the following applications? 

E. Excel

F. Word

G. It depends on your Project file type

H. None of the above

20. When you change a value in a field on a custom form….

E. It will be changed in the underlying project

F. It will not be changed in the underlying project

G. You cannot change a value in a field on a Form

H. None of the above.
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Dim variable name As variable type
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Dim bigNumber As Double



































Dim smallNumber As Integer
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Dim someText As String 





If condition evaluates to true Then statement





If myValue = 100 Then tempValue = myValue + 50





If condition Then
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((Optimistic weight × Optimistic duration) + (Expected weight × Expected duration) + (Pessimistic weight × Pessimistic duration)) ÷ 6


















































